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BIENVENUE DANS FL STUDIO

Ce guide est une introduction générale a I’emploi de FL Studio. Veuillez presser F1 alors que le
programme est en cours afin d’ouvrir le manuel en ligne pour une aide détaillée sur des
caractéristiques ou fonctions spécifiques..

Mises a jour gratuites & vie pour I’édition que vous possédez : saviez-vous que les utilisateurs
ayant acheté FL Studio 2 (il y a longtemps en 1999), ont recu a ce jour FL Studio 3, 4,5, 6, 7 et 8
totalement gratuitement ! Etant donné que le colt moyen d’une mise & jour est de 199€ pour les
logiciels musicaux, cela représente environ 1200€ de mises a jour gratuites. Si vous avez acheté
FL Studio en version boite en magasin, vous pouvez visiter notre boutique en ligne et, pour
I’équivalent d’une paire de pizzas, acheter aussi les mises a jour gratuites a vie. Si vous avez
acheté FL Studio via internet par téléchargement, vous avez déja les mises a jour gratuites a vie
incluses... envoyez-nous la pizza! Comment sommes-nous restés en activité plus de 11 ans ?
Vous noterez que nous avons inclus plusieurs plugins de démonstration dans le programme et
nous misons sur la satisfaction des clients qui les achéteront (Maximus, Poizone, Sawer, Sytrus,
Toxic Bio etc) ainsi que des boucles/échantillons. Notre philosophie est que vous ne devez payer
gue pour ce que vous utilisez, et jamais pour des corrections de bogues (salut a nos
concurrents ?!). Visitez http://www.image-line.com pour voir ce que nous avons a offrir.

Voici juste quelques-unes des fonctions sympas de FL Studio :

- Enreqistrement : audio (microphones, guitares, synthés), automation (mouvements de
boutons / souris) et notes (mélodies polyphoniques) en live, puis modification.

- Couplage facile d’un contrbleur physique : faites un clic droit sur la commande
d’interface de FL, sélectionnez link (“coupler”) et bougez le contrbleur de votre
équipement, c’est tout.

- Piano Roll : le piano-roll le plus poussé du secteur. Des vues par note pour les plugins
natifs FL. Une suit compléte d’outils d’édition et de composition créative.

- Séguenceur pas a pas : séquencage rapide et intuitif a base de patterns, parfait pour les
percussions.

- Editeur d’onde/enregistreur Edison : enregistrez, analysez, éditez et transformez I’audio.
Avec découpage des temps (“beat slicing”).

- Partage : importez/exportez des fichiers .wav (wave), .mp3 (mpeg layer 3), .09g (Ogg
Vorbis), .mid (MIDI) et autres.

- Rapide : bien sdr, le 1égendaire flux de production FL Studio demeure, le chemin le plus
rapide de votre cerveau a vos enceintes !




Lemon Boy est dans la place : eh, les gars ! Des problemes ? Pas de
panique, avant de bombarder d’e-mails I'assistance technique FL Studio,
cherchez moi. J'apparais ici et la avec des réponses susceptibles de vous
aider face aux problemes les plus courants. Bien sdr, n'oubliez pas de
presser F1 dans FL Studio pour ouvrir I'aide en ligne ni de visiter les forums
en ligne a I'adresse http://forum.image-line.com/ .
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INSTRUCTIONS D’INSTALLATION

La procédure d’installation de FL Studio differe Iégérement selon que vous avez acheté le produit
en ligne ou en boite avec un CD et ce manuel. Voici quoi faire :

A. Si vous avez acheté votre copie de FL Studio en version boite, suivez ces étapes :

1.

Lisez le CD. Insérez le CD-ROM fourni dans le lecteur de CD-ROM. Si I’exécution
automatique (auto-run) est activée, le menu du CD apparaitra automatiquement.
Sinon, faites un clic droit sur votre lecteur de CD-ROM dans Windows Explorer et
validez I’exécution automatique (Autorun).

Lancez I’installation. Sélectionnez le lien d’installation FL Studio. La fenétre
d’installation apparait. Suivez les instructions a I’écran.

Le code d’enregistrement. Durant I’installation, un numéro de série vous sera
demandé. Il est imprimé au dos de la carte de cash virtuel d’un montant de 49 €
incluse dans la boite. Notez-le pour I'utiliser ultérieurement et en conserver une copie.

Enregistrement en ligne. Aprés avoir terminé avec succes I’installation, vous devez
vous enregistrer en ligne pour obtenir I’accés aux fonctions supplémentaires du site
internet FL Studio et a sa communauté. Revenez au menu du CD-ROM (rechargez
comme décrit a I’étape 1 si nécessaire), et cliquez sur le lien nommé “Click here to
register to the FL Studio community” ou suivez ce lien :
http://reqister.flstudio.com/box.

NOTE: I’enregistrement est votre assurance contre la perte des CD !

B. Si vous avez acquis votre copie de FL Studio en ligne, version a télécharger, suivez ces
étapes :

1.

Téléchargez et installez la démonstration (Demo). Téléchargez et installez la
version démo de FL Studio. Il est recommandé de ne PAS I’installer par dessus des
versions précédentes de FL Studio ou FruityLoops.

Appliquez un code d’enregistrement (Regcode). A I’adresse http://my.image-
line.com saisissez votre nom et le mot de passe recu par e-mail aprés I’achat. Cliquez
sur le bouton sous votre regcode pour ouvrir une fenétre.

Surveillez vos e-mails. L’équipe FL Studio vous enverra un e-mail avec un lien.
Vérifiez que votre messagerie peut accepter nos emails (domaine: image-line.com).
Veuillez suivre attentivement les instructions.

Lancez le programme. Faites redémarrer FL Studio s’il est déja lancé et vous
pourrez sauvegarder vos projets.
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5. Ajoutez le site internet a vos favoris. Le site internet FL Studio http:/
flstudio.image-line.com est une ressource impressionnante. Visitez-le souvent pour
voir ce qu’il y a de nouveau.

6. Lisez ce guide. Dés que vous aurez lancé FL Studio, vous serez confronté a
d’étranges boites de dialogues et messages. Passez a la section suivante de ce guide
pour savoir quoi faire ensuite. Consultez aussi I’aide en ligne compléte qui est fournie
avec FL Studio.

En cas de problémes, veuillez consulter notre base de connaissances interrogeable :
(http://support.image-line.com/knowledgebase) et nos forums d’assistance (http://forum.image-
line.com). Pour une assistance relative a la commande ou a I’enregistrement, veuillez créer un
ticket idoine sur notre site internet http://support.image-line.com.

PREMIER LANCEMENT

OK, ainsi vous avez terminé I’installation et lancé FL Studio. Cette section explique ce que vous
verrez.

1. Fenétre Settings (configuration du systéme). Lors de la premiére utilisation de FL Studio,
vous devez presser F10 sur le clavier de votre PC pour I’ouvrir. Utilisez les cases de
sélection pour choisir votre carte son et vos contrdleurs physiques. D’abord, vous pouvez
regarder la fenétre MIDI, mais pour le moment, le plus important est la fenétre Audio,
accessible comme indiqué ci-dessous.




2. Sélectionnez un pilote de carte son dans le menu déroulant. Sélectionnez si possible un
pilote ASIO (portant le mot “ASIO” dans son nom), car il permettra des tailles de mémoire
tampon (“buffer”) plus faibles (voir ci-dessous) pour une charge de processeur moindre que
les pilotes DirectSound. Si votre carte son ne prend pas en charge I’ASIO de fagon “native”,
le pilote ASIO générique ASIO4ALL ( http://asiodall.com ) doit convenir. Si vous ne savez
pas lequel choisir, gardez la sélection par défaut. En cas de problémes par la suite, il sera

ASIO4ALL v2 L Auka close device

Skatus: open, set ko 44100Hz, Int32LSE, 4x2 outputs, 1x2 inputs available

(Mier 4

Sample rate (Hz):

v, 2. Puis ici

ASIO properties

Euffer lemgth: 416 sarples (10ms]

Inkerpolation: Linear

Show ASIO panel

Priarity; m

Resek plugins on ktranspark
O use mixer as playvback pogti

Input / output
Primary Sound Driver Auto close device

Status: open, sef ko 44100Hz, 166it sterea

[Viver 4
Buffer length: 1728 samples (40ms) Sample pake (Hz):
LN A A R

Use palling
Use hardware buffer
Lise 326it buffer

Priority: m

safe overlnads

Reset plugins on kranspork
O Use mixer as plavhack position

Preview mixer track:

Underruns: 0

toujours temps de revenir a cette fenétre (en pressant F10) pour essayer les autres options.

Le terme “carte son” est employé trés librement; il peut s’agir d'une carte
son séparée dans votre PC, d'une puce sur votre carte mere ou d’'une
interface externe branchée en USB/FireWire etc. La carte son est tout
dispositif qui permet d’entendre le son par les haut-parleurs de votre PC.
Le pilote de carte son est linterface logicielle entre le systeme
d’exploitation Windows et la carte son. Il indique a FL Studio les entrées/
sorties de la carte et les fréquences d’échantillonnage qu’elle accepte.




®

3. Buffer Length (taille de mémoire tampon). Vous n’avez pas besoin de connaitre la plupart
des éléments de cette fenétre, mais vous devez savoir ce que fait la taille de mémoire tampon
ou Buffer Length. La mémoire tampon ou buffer audio est un stockage temporaire de données
audio attendant d’étre envoyées a la carte son. Cela permet a FL Studio de réguler les pics
momentanés de charge du processeur. Si le buffer audio est vide parce que votre PC n’arrive
pas a le remplir assez vite, votre carte son produira des bruits désagréables de pop, clic ou
transitoire (une sous-alimentation de la mémoire tampon connue sous le nom de buffer
underrun). Il est important de noter que cela ne peut se produire QUE lors d’une lecture en
temps réel, pas dans des fichiers audio exportés. Agrandir le buffer réduit ces sous-
alimentations au prix d’une sensation de moindre réactivité de FL Studio lors du travail en
live. Essayez empiriquement de trouver une taille de buffer suffisamment basse pour que FL
Studio reste réactif mais pas au point de ne pas pouvoir maintenir un contenu en mémoire
tampon. Nous avons constaté qu’a 10 ms environ (440 échantillons), le jeu n’en valait plus la
chandelle et la charge du processeur grimpait sérieusement sans amélioration notable.
Essayez avec 10-30 ms. Pour un pilote DirectSound standard, les options “Use Polling” et
“Use hardware buffer” peuvent améliorer la latence de certains systémes d’exploitation (2
options x 2 états = 4 combinaisons, essayez-les toutes), vous pouvez espérer des réglages de
buffer de 20-40 ms.

4. La fenétre principale. Aprés avoir fermé la fenétre Settings, vous verrez une fenétre
similaire a celle-ci-dessous (les fenétres intérieures seront sans doute placées différemment).
Le bureau de FL Studio est basé sur plusieurs fenétres, dont la plupart sont flottantes (avec
recouvrement), redimensionnables, agrandissables et commutables aussi quand une fenétre
mentionnée ci-dessous n’est pas visible, vous pouvez la rappeler a l'aide de la barre d’outils
des raccourcis-clavier (ou des touches de fonction notées entre parenthéses ci-dessous). Les
trois principales fenétres impliquées dans la création musicale avec FL Studio sont Channels
(canaux : F6), Mixer (table de mixage : F9) et Playlist (liste de lecture : F5).




Didacticiels vidéo ! Une illustration vaut 1000 mots, alors que dire
d’une vidéo, peut-étre des MILLIARDS...une fois enregistré, faites
un tour sur le site internet FL et regardez des heures de
didacticiels vidéo sympas, vraiment utiles, alors je CRIE —

http://tutorials.flstudio.com

10
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FAISONS UN PEU DE BRUIT

Pressez le bouton Play (vérifiez aussi que le sélecteur de gauche est en
mode SONG). Vous entendrez le morceau de démo. Si ce n’est pas la
premiére fois que vous ouvrez FL Studio, vous devez recharger ce
morceau de démonstration. Ouvrez le navigateur (F8), faites un clic gauche sur le dossier
"Projects" et un clic droit sur NewStuff.flp, puis sélectionnez ""Open' dans le menu. Vous
pouvez aussi faire glisser le fichier flp sur le bureau, cela I'ouvrira aussi. Les fichiers FLP sont
des fichiers de projet FL Studio qui sauvegardent des morceaux entiers.

A L’AIDE (menu HELP) !

Ce guide n’est la que pour vous aider a prendre en main le logiciel — ce n’est pas un mode
d’emploi exhaustif détaillant tout ce que FL Studio peut faire (ce qui est le réle de I'aide en ligne
(pressez la touche F1 du clavier de votre PC) et de la bible FL Studio). Voyons en bref les
principaux composants de FL Studio :

1. Barre d’information. Elle est située dans la fenétre principale juste sous la barre de menu
(en haut a gauche de I’image de la page précédente). Quand votre souris survole n’importe
quelle commande de FL Studio, ce panneau affiche une breve description de ce que fait cette
commande et sa valeur lorsque vous la bougez. La barre d’information indique également le
raccourci clavier qui active cette fonction. Le raccourci est affiché sur la droite. Presser ce
raccourci clavier a le méme effet que presser le bouton correspondant.

Barre FILE EDIT CHANNELS VIEW OPTIONS TOODLS HELP
d’infornmﬁ

Mix lewel Cir+T =

2. Aide en ligne. FL Studio est aussi fourni avec une aide en ligne de référence compléte.
Utilisez juste le Menu Help et sélectionnez Contents. Cette aide est également contextuelle
— sélectionnez une fenétre et pressez F1 sur votre clavier. L’aide recherchée s’affiche
automatiquement. Vous remarquerez trois onglets, CONTENTS (I’aide), INDEX et
SEARCH (recherché). Les deux derniers peuvent étre interrogés par mots-clés, essayez !

3. Boucles de didacticiels. Cliquez sur File >Open, recherchez et ouvrez le dossier Tutorials.
Ces boucles présentent la marche a suivre pour réaliser différentes opérations dans FL Studio.

4. Le site Internet. FL Studio possede un immense site internet a [|’adresse
http://www.flstudio.image-line.com. Ce site comporte une section d’assistance avec une base
de connaissance ou FAQ (foire aux questions fréquemment posées), des forums

11
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d’utilisateurs, des didacticiels en ligne, des didacticiels vidéo, un échange de morceaux et
plus encore. Consultez les forums de discussion pour voir si des réponses ont déja été
apportées a vos questions, ou identifiez-vous et posez-les.

POUR COMMENCER

La section suivante vous guidera au travers de quelques-unes des fonctionnalités basiques (ou
non) que vous emploierez pour faire de la musigque avec FL Studio. Consacrez toutefois un peu de
temps au fichier d’aide en ligne (pressez F1 dans FL Studio) et travaillez au moins sur les
sections Setup Wizard (assistant de configuration) et Introduction to FL Studio (Introduction a
FL Studio).

HEY ! Ne sautez pas cette étape. Ce
guide sera beaucoup plus efficace si
vous le lisez d’un bout a I'autre.

FENETRE CANAUX ET SEQUENCEUR PAS A PAS

Lorsque vous lancez FL Studio pour la premiére fois, la fenétre Canaux (Channels) s’affiche a
I’écran (voir la section "Premier lancement™). Les canaux sont des instruments qui peuvent
envoyer de I’audio a n’importe quelle voie de la table de mixage (déterminée avec le sélecteur de
voie de mixage Channel Settings). Quand vous cliquez avec le bouton gauche sur un bouton de
canal, cela ouvre les réglages de canaux (Channel Settings) (et I’interface du plugin s’il en a
une, comme par exemple le Sytrus) et quand vous cliquez avec le bouton droit, cela sélectionne le
Piano Roll. La fenétre des canaux contient aussi le séquenceur pas a pas, avec une grille par
défaut idéale pour créer des rythmes par déclenchement d’échantillons de percussion chargés
dans les échantillonneurs des canaux. Le Piano Roll (page 67) convient mieux aux compositions
plus complexes.

12
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1. A quoi servent les canaux ? Les canaux sont représentés horizontalement (voir ci-dessous)
et contiennent chacun un instrument ou son unique. Chaque séquenceur pas a pas de canal
comprend par défaut 16 pas. Si vous vous intéressez au solféege, sachez que chaque pas
correspond a une double-croche. Dans le cas contraire, sachez que chaque groupe de quatre
pas correspond a un temps, donc 16 pas correspondent aux quatre temps d’une boucle de
batterie basique.

Changezici le

nombre de pas = i 082
Canal A i
Pas, On ou
Elgr?;dsuur Off (activé
ou non
le bouton )

2. A quoi servent les pas ? Cliquez sur un pas pour I’activer, cela indique a FL Studio de
déclencher I’instrument chargé dans ce canal a cet endroit de la mesure ou boucle. Ici, les ler,
5eme, 9eme et 13eme pas du 1% canal Kick sont sélectionnés, demandant a FL Studio de
jouer les sons de grosse caisse quatre fois par boucle (si on assimile les groupes de quatre pas
a des temps, FL Studio joue ces sons au debut de chaque temps). Essayez de changer le motif
des pas du canal Kick (pour désactiver un pas, faites un clic droit dessus). Une fois les pas
allumés comme dans I’illustration ci-dessous, pressez le bouton de lecture pour entendre ce
gue vous avez créé.

13
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Pattern
suggéré

Commandes
Mute, Pan &
Vol de canal

Lors de la programmation de patterns,
utilisez le mode PAT. FL Studio lira
alors le pattern sélectionné.

Comment utiliser les Patterns ? Alors qu’il est sympa de faire tout un tas de Patterns, il
n’est pas particulierement utile de lire indéfiniment une méme boucle (2 moins d’un beeuf a la
guitare, par exemple). L’astuce consiste a placer ces Patterns dans la Playlist (qui sera
détaillée plus loin). Toutes les données de
note continues dans la pile des canaux
d’instrument en fenétre des canaux forment ce
que I’on appelle un "Pattern”. Vous pouvez
changer de Pattern avec le sélecteur "PAT" du panneau Transport. Si vous le faites, les
données de note visibles dans le Pattern actuel changent pour refléter le Pattern sélectionné.
Pour n'entendre que ce Pattern (plutt que toute la liste de lecture ou Playlist), vérifiez que le
bouton a l'avant du panneau Transport est en mode "PAT". Une fois que vous avez créé
plusieurs Patterns, vous pouvez en sélectionner un a I’aide du sélecteur PAT (ou du sélecteur
de clip de Playlist) pour le placer dans la Playlist comme clip de Pattern (zone supérieure) ou
bloc de Patterns (zone inférieure).

Jouez avec les réglages de canal. Une fois le Pattern configuré, faites des essais avec les
réglages de canal situés a gauche. Les deux boutons rotatifs reglent le volume et le
panoramique du canal correspondant, la diode verte indiquant si le canal est activé ou
désactivé. Le panoramique est similaire a la commande de balance sur une chaine stéréo.
Tournez-le pour déplacer le son entre gauche et droite dans le champ stéréo. Pour ramener un
bouton rotatif a sa position par défaut, faites un clic droit dessus et sélectionnez Reset.

Créez votre propre rythme. Le rythme de cet exemple ne vous plait pas ? Pas de probléme,
créez le vétre ! Dans les sections suivantes, nous verrons justement comment charger de
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nouveaux échantillons (Samples), définir des mélodies et modifier le son de chaque canal
(et méme de chaque pas) a I’aide des Plugins d'effets .

Jouezici

Sélectionnez
le Pattern a
placer ici a
I'aide du
“Sélecteur de
clip”

Mode crayon
ou pinceau

o

| Cliguez avec le bouton
gauce sur es zones

| Pattern 2 Bl Viermur a]outel‘ le

Pattern sélectionné

Découvrez-en plus sur la Playlist en page 26.

15
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EDITION DES CANAUX

Dans cette section, nous verrons comment modifier le son des échantillons) dans chaque canal
d'échantillon. FL Studio propose un tel éventail de réglages qu’il est possible a deux personnes de

N

créer des boucles radicalement différentes a partir d’échantillons pourtant identiques
(techniquement parlant, chaque canal comprend un Instrument, qui peut étre un échantillon ou
un plugin de synthétiseur). S'il existe des échantillonneurs dédiés comme FPC (percussion) &
DirectWave (instruments), I'échantillonneur & simple canal est un outil polyvalent et utile.

Attendez ! Qu’est-ce qu'un "échantillon" ? C'est un son
enregistré dans un fichier. Chaque canal de FL Studio exploite
par défaut un échantillon unique contenant en général une
note (comme un son de caisse claire ou une note de basse),
mais parfois des rythmes (boucles), voire des morceaux
entiers. Les échantillons sont souvent des fichiers ".wav", mais
FL Studio accepte aussi les fichiers ".mp3" et “.000".

1. Chargez un nouvel échantillon. Regardez dans le navigateur. Une facon de charger les
échantillons consiste a utiliser le navigateur (l'autre fenétre vue en ouvrant la premiére fois
FL Studio dans la section "Premier lancement™ précédente). C'est un navigateur spécial pour
sélectionner et charger les échantillons, boucles et presets. Pour trouver un son de grosse
caisse, cliquez sur Packs, puis sur Dance. Un clic gauche sur un échantillon de la liste le fera
jouer, un clic droit I'ouvrira dans le canal sélectionné. Vous pouvez aussi le glisser- déposer
dans le séquenceur pas a pas (sélectionnez un canal en cliquant sur la diode verte Sélecteur
de canal a droite du nom de canal comme illustré ci-dessus.

16

=l|=#Browser “Snap 1+

ms avez perdu le navigateur ? Pash

probléme. Les cing gros boutons de la
barre d'outils ci-dessous ouvrent et

Cliquezici ferment diverses fenétres, dont le
Basses navigateur et le séquenceur pas a pas.
'[_:“:: (Ne vous souciez pas encore des autres,
tout s'éclaircira avec le temps...)
Puis ici
Etici

Ouvre le
navigateur

[Iru}nLc.
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2. Ouvrez la boite de dialogue Channel Settings (clic gauche sur un bouton de canal). OK,
modifions I’échantillon de grosse caisse. Chargez un son de grosse caisse (ci-dessous) et
ouvrez la fenétre Channel Settings de ce canal d'un clic gauche sur le bouton de nom. Un
autre moyen de changer d'échantillon, c'est I'icone de fichier Ouvrir a gauche de la fenétre de
nom d'échantillon (ci-dessous). Elle ouvre un navigateur sur le répertoire contenant les
échantillons de grosse caisse. Quand vous cliquez sur ceux-ci, FL Studio les joue
automatiquement. Essayez d'ouvrir certains de ces échantillons et d'écouter I'effet d'une
nouvelle grosse caisse sur le son de la boucle.

C|IqueZ Lol ||(EER

ici L 'i":":":"i“lz‘ Channel settings - Kick

I )i e : Nom du

Sélecteur - fichier

de canal échantillon
- @@ [zl 0 BBEEG (sample)

Quvrir
fichier .
= Resample

Precomputed effects

Sauvegardez ! Sivous avez créé un
chef-d'ceuvre et voulez le conserver,

§ AL STODID EuroGloss_TheDecisionMix.fl

n'oubliez pas de sauvegarder. "Save FILE EDIT CHAMNELS VIEW OPTIONS 10

new version" est une fonction pratique Mew

pour cela qui ajoute un suffixe Mew from template

1,2,3...etc a la fin du nom de FLP Open... Ciri+0

pour que vous conserviez vos

anciennes versions. ave S
— Save as... SO+

Save new version

17




®

3. Jouez avec les effets de canal d’échantillon. Il est utile de noter que FL Studio peut ajouter
des effets audio aux voies de mixage (réglés par le sélecteur d’effet FX), mais cette section a
pour but de vous montrer la puissance des effets d’un canal échantillonneur. Ok, la meilleure
chose a faire maintenant est de lancer la boucle et de jouer avec les commandes du panneau
d’échantillon (SMP) dans la boite de dialogue Channel Settings pour écouter I’influence de
ces réglages sur le son. Voici une courte description de quelques-unes d’entre elles. Reportez-

vous a I’aide en ligne pour obtenir de plus amples informations.

Vol, Pan : ces molettes de
volume et de panoramique
sont également présentes sur
chague canal dans la fenétre
principale. Le réglage est
répercuté en temps réel sur les
boutons de la fenétre des
canaux.

Remove DC Offset : utilisez
cette option pour corriger le
décalage “vertical” des
échantillons (voir fenétre
d’onde ci-dessous).
Reverse Polarity : "renverse”
verticalement la forme d’onde.
Normalize : maximise le
volume de I'échantillon sans
distorsion.

Fade Stereo : crée un fondu
stéréo du canal gauche au
canal droit de I'échantillon.
Reverse : inverse I'échantillon.
Swap Stereo : échange les
canaux gauche et droit de
I'échantillon.

[PLuGn 'smp [ms [misc [Func

" | FL Studio Rocks My World.wav

|Wave
[ n disk |

i

Loop

| Time stretching

' Resample

Fade In (IN) : applique un fondu
montant rapide a I'échantillon (&
fond & gauche, il est désactivé).
Fade Out (OUT) : applique un
fondu descendant rapide a
I’échantillon (a fond a gauche, il
est désactivé).

Pitch bend (POGO) : applique
une variation de hauteur (pitch
bend) a I'échantillon. Utile avec
des échantillons de batterie.
Crossfade Loop (CRF) :
permet un fondu-enchainé
(crossfade) de I'échantillon pour
créer des bouclages
transparents (a fond a gauche, il
est désactive).

Trim Threshold (TRIM) : FL
Studio coupe le silence en fin
d’échantillon pour libérer de la
RAM sans modifier le son. Cette
commande détermine le seuil de
volume sous lequel FL Studio
considére le son comme du
"silence".

Fenétre d’onde : affiche la
forme de I'échantillon
sonore. Cliquez ici pour
entendre I'échantillon avec
tous les effets. Sert aussi
au glisser-déposer pour
charger des échantillons.

Vous n’entendez pas de différence ? Si vous pressez un bouton
ou tournez une commande mais n'entendez aucune différence,
essayez sur un autre canal. Exemple : Un réglage peut avoir un
effet nul sur une grosse caisse mais considérable sur le son d'une
caisse claire. Si vous n’entendez pas de différence, arrétez la
lecture de la boucle et isolez un son en cliquant sur sa forme
d’onde dans la fenétre d’'onde. L’effet sera davantage perceptible
sans les autres instruments.
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4. Ajoutez de I’écho. Ouvrez la fenétre Channel Settings d’un échantillon de grosse caisse et
cliquez sur I’onglet FUNC pour afficher la fenétre ci-dessous. Les commandes de la section
supérieure (Echo delay / fat mode) permettent de définir un effet d’écho particulierement utile
a un instrument seul. Commencez par augmenter le réglage FEED d’un quart de tour ;
écoutez le résultat sur le son de grosse caisse... Modifiez I’écho a I’aide des autres réglages...
Vous pouvez aussi alterner entre divers modes d'écho et “fat” en cliquant sur la barre de titre
de la section Echo Delay (par défaut, Classic Echo). Vous en saurez plus sur ces différents
effets dans le manuel en ligne...

Feed : volume de
I'écho (vitesse a
laquelle I'écho
disparait).

Ping Pong : fait
basculer le son de
I'écho entre gauche
et droite (rend trés
bien au casaue).

Arpeggiator : la
description de cet
effet est donnée
dans la section
Instruments de ce
manuel.

[~] Channel settings - FL Studio Rocks ... [ |

+ 3
re e
B~ |~ ? |Arpeggiator

FOROIEST I\ |

cHoRD | Auto (sustain)

|voL [[Bl Tracking

Pan, Cut, et Res ont le méme
rle que celles du panneau
échantillon mais les effets
montent quand I'écho s'affaiblit.

Pitch contréle la hauteur de
I'écho. Si vous tournez ce
bouton a droite, I'écho est plus
aiau a la fin de I'effet.

Ech : nombre d’échos de
l'instrument joués avant que
I'écho ne s'arréte.

Time : détermine l'intervalle (en
pas) entre chaque écho.
L'intervalle maximum est de 16
pas.

Réglage précis du parametre Time de I’écho : le
réglage "Time" est particulierement précis afin de vous
permettre de définir exactement I'écho souhaité. Pour

obtenir un écho en rythme, tournez ce potentiometre

en regardant la barre d'information. Pour entendre un
écho tous les trois pas, tournez le potentiometre
iusau’a ce aue "3:00" soit affiché a I'écran.
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Jouez sur les réglages des instruments. Regardons rapidement le panneau INS avant d’aller
plus loin (il y a aussi des choses a lire sur MISC, voir l'aide FL dans Help). Cliquez sur
I’onglet INS pour accéder aux réglages d’instruments. Cet onglet vous permet d’appliquer
des enveloppes et des LFO aux réglages de volume, de panoramique, de coupure et de
résonance du filtre, ainsi qu’aux réglages de hauteur de votre échantillon.

Sé|eCtI0nnez Ce rIz‘ Channel settings - Kick
commutateur pour |
actlver PR oL FITEH

lm s WW

Sélecteur d'effet

Enveloppe

|Filter

LFO
Faites un clic droit sur

e o IHHNJWJINJWHJ

de base)

Qu’est-ce qu’une enveloppe ? Une enveloppe fait varier la valeur d’un parametre durant la
vie d’un son. Une des plus courantes est I’enveloppe de volume qui fait monter puis chuter le
volume du son. On peut aussi définir une enveloppe affectant la hauteur, la fréquence de
coupure et la résonance du filtre. En termes d'enveloppe de volume (VOL), le délai (DEL)
fixe le temps qui s'écoule avant que I'enveloppe ne démarre, l'attaque (ATT) est la vitesse de
fondu entrant, le maintien (HOLD) détermine le temps pendant lequel le son est joué au
volume maximal, et le déclin (DEC), le sustain (SUS), et le relachement (REL) contrdlent la
disparition du son. Jouez avec les boutons et regardez le dessin changer en dessous d'eux.

Qu’est-ce qu’un LFO ? LFO signifie Low Frequency Oscillator (oscillateur basse
fréquence). Il agit comme une enveloppe mais répéte indéfiniment une forme d’onde pendant
gu'une note est jouée. Il sert le plus souvent a faire osciller en haut et en bas la hauteur
pendant la durée d'un son (vibrato). L'amplitude (AMT) détermine la profondeur de
I’oscillation, la vitesse (SPD) la rapidité de I’oscillation, le délai (DEL) le temps avant le
début de I’oscillation, I’attaque (ATT) la rapidité a laquelle I’oscillation atteint son intensité
maximale. Modifiez les réglages a I’aide des potentiométres et regardez le graphique changer.
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Comment les utiliser ? Utilisez le sélecteur d’effets (voir illustration ci-dessus) pour
sélectionner I’effet, puis tournez les potentiométres de I'enveloppe et/ou du LFO. Cliquez sur
la diode témoin d’activité pour activer/désactiver I’enveloppe sur chaque effet. Ramenez le
potentiometre Amount (AMT) au centre (orienté vers le haut) pour désactiver le LFO.

8. Pourquoi je n’entends pas I’effet ? Si vous étes toujours sur la grosse caisse, vous aurez
effectivement du mal a percevoir I’influence du LFO, méme si celle de I’enveloppe est
perceptible. Ces effets sont plus notables sur les échantillons plus longs ou sur des sons
d’instruments tenus comme 30SC.

@j vous faites un clic gauche sur un bouton de

canal, la fenétre Channel settings s’ouvre avec
l'interface du plugin. Vous constaterez que certaines
commandes de Channel settings n’ont aucun effet sur le
son, c’est normal. Généralement, pour les plugins
d’instrument, le sélecteur FX de Channel settings sert a
envoyer l'audio a une voie de mixage. L'onglet FUNC
(fonction) de la fenétre Channel settings est toutefois bien
pratique avec les plugins d’'instrument. Essayez avec
I’Arpeggiator, super pour jouer en live sur un clavier MIDI.

On va pouvoir passer aux choses sérieuses ! ...ou

QPC a-t-il déja pris feu ?

Mixer - Sytrus. i

3 8 s 6 e 3 |

° Q@[
,mﬁ Channelwmdow ‘ £ Channel settln s |

Al
SBEEEEEREREEE

Trajet du signal, des canaux a la table
de mixage
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AJUSTEMENT DES PROPRIETES DE NOTE

Vous connaissez maintenant quelques moyens offerts par FL Studio pour régler et modeler vos
sons. Dans cette section, nous allons vous montrer comment certains de ces effets peuvent étre
appliqués séparément sur chaque pas. Nous vous montrerons aussi comment programmer des
mélodies. Notez que si vous avez Fruityloops edition ou supérieur, nous vous recommandons
fortement d'employer le Piano Roll au lieu du séquenceur pas a pas pour le travail mélodique
(voir page 67).

1. L’éditeur des niveaux. L’un des outils les plus simples & prendre en main est sans doute
I’éditeur graphique. Sélectionnez tout d’abord le canal a éditer en cliquant sur le nom de ce
canal ou en cliquant sur la diode verte de sélection a droite du nom du canal. Appuyez ensuite
sur le bouton de I'éditeur graphique qui le fait s’afficher comme ci-dessous.

Sélecteur Bouton de
d | |’éditeur des
e cana nivealix
Editeur
graphique

Sélecteur de
cible

2. Seélecteur d'effet. Essayez de cliquer et de tirer sur le Sélecteur de cible sous le graphique
pour voir quels effets peuvent étre édités graphiquement. VVous verrez Pan, Velocity (un autre
nom pour le Volume), Filter Cut (coupure du filtre), Filter Res (résonance du filtre), Pitch
(hauteur) et Shift (décalage). Si certains effets ont déja été évoqués en section "Edition des
canaux", ici la différence est que vous pouvez également éditer les valeurs d'effet pour
chaque pas. Chaque barre détermine la valeur de I’effet pour la simple note représentée au-
dessus (ou au-dessous).
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3. Panoramique de la grosse caisse. Essayez de reproduire les réglages de panoramique ci-
dessous. Le graphique du panoramique est centré au milieu. Les valeurs s’éditent en cliquant
au niveau souhaité dans la barre associée a chaque note. Une fois obtenu le résultat ci-
dessous, le son de la grosse caisse basculera d’une enceinte a I’autre. Le résultat est excellent
si vous combinez ce réglage avec I’écho a 3 pas ajouté dans la section précédente...

—
e

5@ ’7 | BEB0EN00EEE0EEE
o @@l

5@ @ ezl

All
=

4. Essayez le volume (dynamique ou ""Velocity'). Vous pouvez appliquer des effets de fondus
entrant et sortant sur un Pattern avec le graphique Velocity. Essayez de remplir tous les pas,
ouvrez I'éditeur graphique sur Velocity puis apportez des variations comme celles ci-dessous
(clic gauche sur les barres puis tirez vers le haut/bas). Quand vous pressez Play (en mode
pattern), vous entendez le volume monter a chaque pas. Ce graphique n'est pas centré au
milieu comme le panoramique mais va de zéro (en bas) a une valeur maximale (en haut). Ces
variations peuvent trés bien sonner en combinaison avec des variations de fréquence de
coupure (Cutoff) et de résonance (Resonance). Astuce : pour tracer une pente réguliere dans
I’éditeur graphique, faites un clic droit sur la premiére barre puis faites glisser la souris vers la
droite pour définir d’un coup les valeurs de toutes les barres.

o

i [ |

ol @ i C000000000000000

o @@zl
|I||IIIIII||

L] [velosity |

All
L
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Jouez avec les autres effets. Faites des essais avec les autres effets de I’éditeur graphique. La
coupure (Filter Cut) et la résonance du filtre (Filter Res) peuvent servir a ajouter ou
retrancher des valeurs aux boutons principaux de coupure et résonance du filtre définis dans
I’onglet INS de la boite de dialogue Channel Settings (voir la section "Edition des canaux").
Pitch permet de jouer I’échantillon plus haut ou plus bas, comme le bouton Pitch de la boite
de dialogue Channel Settings. Shift peut étre utilisé pour décaler un pas plus prés du pas
suivant (les meilleurs musiciens pourront utiliser ce paramétre pour donner du groove a leurs
rythmes).

Faites des mélodies. Généralement, le Piano Roll est le meilleur endroit pour la composition
mélodique (clic droit sur un bouton de canal), toutefois si vous avez chargé un instrument
mélodique (comme l'instrument "30SC"), le clavier d'édition peut aussi servir. Pour charger
""30SC", faites un clic droit sur un bouton d'instrument et utilisez la commande "'replace"
du menu contextuel. Pour éditer les notes de cette mélodie, cliquez sur le bouton du clavier
d’édition alors que le canal 30SC est sélectionné comme ci-dessous. Un clavier vertical
s’affiche pour chaque pas. Espérons maintenant que vous en savez un minimum sur les
claviers (sinon, il est temps de prendre quelques lecons !). VVous pouvez éditer chaque note en
faisant un clic gauche sur les touches du clavier. Faites un clic droit pour désactiver la note.
Quand la boucle ne joue pas, cliquer sur une note la fait jouer. Mais une fois encore, le Piano
Roll est plus adapté a un travail mélodique sérieux.

Sélecteur | mia= Elc;tjlfgrn o

de canal s [ 0EEE0E000EEE0EEE d’édition
Qe M U000000ROR0RCOR0

Bouton de

glissé de

note

Clic gauche pour ajouter des notes, cliquer-
tirer pour déplacer, clic droit pour supprimer.
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Conseil super important. Quand vous souhaitez créer une mélodie a partir de longs
échantillons, il est souvent préférable de la configurer pour que chaque note coupe la
précédente. La facon de faire la plus simple consiste en un clic droit sur le nom du canal
dans le séquenceur pas a pas suivi d'une sélection de I’option Cut Itself du menu contextuel.

[ | (K0

Rename...
Seticon

Load sample...

Insert
Replace »
Clone

Delete...
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LA PLAYLIST (des Patterns aux morceaux)

Vous avez maintenant vu les bases de ce qui peut étre fait avec les sons échantillonnés
(échantillons ou "samples) d’un méme Pattern. Cette section vous montrera comment
programmer plusieurs Patterns et les associer a I’intérieur d’une boucle plus longue.

1.

26

Le sélecteur de Pattern. FL Studio vous permet de créer 999 Patterns différents de
n’importe quelle longueur. Dans les sections précédentes, vous ne travailliez qu’avec le
Pattern 1 mais vous pouvez accéder a d’autres Patterns en changeant le numéro dans le
champ de numéro de Pattern. Utilisez votre souris pour tirer sur le sélecteur de Pattern ou
utilisez les touches numériques "1" a "9" ou "+" et "-"). Vous trouverez ces commandes dans
la barre d’outils en haut de la fenétre principale de FL Studio. Faites un clic droit sur le

sélecteur de Pattern pour afficher tous les Patterns qui contiennent des données.

Champ de
Sélecteur de numéro de
mode Pattern
Pattern/Song

Témoin de position de lecture

Contrélez la liste de lecture ou Playlist. Cette fenétre peut étre ouverte en utilisant le
bouton situé sous la barre d’information, en appuyant sur la touche F5, ou en faisant un clic
droit sur le bouton Song/Pat de la fenétre principale (voir ci-dessus). Essayez et une fenétre
ressemblant a celle ci-dessous devrait s’afficher a I’écran. Cette fenétre s’apparente a celle
des Patterns, a ceci prés que les pas sont associés a des Patterns entiers et plus a des canaux
individuels, et que la longueur des barres refléte la longueur des Patterns. Assurez-vous que
I’option Song est sélectionnée et appuyez sur Play. Vous devriez alors voir la téte de lecture
de la Playlist se déplacer et entendre les Patterns qu'elle joue (utilisez NewStuff.flp). Quand
le témoin atteint la fin des pas, il revient au point de bouclage du morceau et la lecture
continue. Essayez de déplacer le point de bouclage (faites un clic droit a I’endroit ou vous
souhaitez le placer) et écoutez le résultat (si vous sélectionnez I’option Pat, FL Studio se
contente de répéter le Pattern courant dans le séquenceur pas a pas).

Super.




p= | B

¢l Panning I Panning | Panning ¢l Panning | Panning #| Panning ¢l Panning

#Vocals: The Girl - Combined view #Vocals:

En haut ou en bas ? La Playlist a une zone supérieure et une zone inférieure (au-dessus et
au-dessous du séparateur). Les pistes de clips (en haut) sont une caractéristique de FL Studio
(Producer edition uniquement). Nous avons fait quelque chose de bizarre alors faites
attention ! Une occurrence de Pattern peut étre placée dans une piste de clips OU dans une
piste de blocs. Dans I'exemple ci-dessus, nous avons placé chaque Pattern A LA FOIS dans la
piste de clips et dans la piste de blocs pour que vous puissiez voir ou placer les Patterns, mais
vous n'avez besoin que de I'une ou de l'autre pour faire jouer le Pattern. Les pistes de clips ont
I’avantage d’afficher les données qu’elles contiennent, tandis que les pistes de blocs sont un
peu plus facilement déchiffrables pour créer des projets simples. FL Studio a les deux car la
piste de clips a été une évolution de I’affichage par piste de blocs. Qui sait de quoi demain
sera fait ?

A quoi ca sert ? Vous pouvez a présent assembler des Patterns pour constituer un morceau
("Song"). Cette fenétre vous permet de modifier les mélodies, de changer les rythmes,
d’insérer des transitions et de réutiliser certaines séquences plus loin dans le morceau. Les
pistes de clips affichent plus d'informations sur les données que contiennent Patterns & clips.
Les blocs sont plus minimalistes. C'est a vous de voir comment vous voulez travailler. De
nombreux compositeurs utilisent des blocs de Patterns distincts pour la batterie, la basse, la
guitare solo, etc. pour pouvoir les travailler séparément avant d’assembler le morceau dans la
Playlist. Un bon moyen de voir une Playlist exploitée a fond est de regarder NewStuff.flp ou
les flp du dossier "Cool Stuff” avec le navigateur.

27




®

5.

28

Types de données : chaque piste de clips (partie haute) peut contenir un nombre illimité de
clips d'automation, de clips de Pattern et de clips audio. Pour ajouter une nouvelle occurrence
d'un clip, sélectionnez le clip a coller avec le sélecteur "Coller piste" et cliquez a un endroit
vide dans les pistes. Essayez de déplacer les ondes ou de les couper avec le cutter. Dans I’aide
en ligne, vous trouverez d’autres projets didacticiels vous expliquant comment les utiliser
ainsi que plein d’informations (dans FL Studio, pressez F1). D’autres informations sont
disponibles dans le chapitre Pistes audio. Vous pouvez appliquer des enveloppes
d'automation (par ex. pour un fondu entrant/sortant de clip audio) sur ces clips audio.

v}||- - Kick

‘ PatternCInp{Events) . ‘ . ‘ .

'Fs:l

—Pattern -Clip-( {Notes)— L]

s - The Gitl

4 |Main automation

J'y suis ! La Playlist du haut a tout un tas de "pistes de clips" génériques et
les commandes situées a gauche des pistes servent a les nommer et a les
rendre muettes. Les données musicales de note, d'échantillon et
d'automation peuvent étre organisées dans n'importe quelles pistes de clips
du haut (elles ne sont pas regardantes quant a ce qu’elles contiennent) ou en
blocs dans la partie basse de la Playlist, seuls les clips audio ne pouvant pas
aller en bas...facile...je pense... qu'est-ce que c'était déja ?!
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INSTRUMENTS (des échantillons aux synthétiseurs)

Jusqu’a présent, nous avons surtout travaillé avec des canaux d’échantillons. Mais sachez que FL
Studio offre également des canaux contenant des sons créés en temps réel par des synthétiseurs
logiciels comme PoiZone, Sytrus, Wasp, SimSynth Live etc.. Pour utiliser la bonne terminologie,
chaque canal contient un instrument (parfois généralement appelé un "générateur") qui peut étre un
échantillon (dans un canal d’échantillon), un plugin de synthétiseur ou un autre type d'instrument
combiné aux effets définis dans la boite de dialogue Channel Settings. La combinaison de ces
générateurs avec les canaux d’échantillons offre un surcroit de puissance majeur a FL Studio !

1. Ajout d’un canal de synthétiseur. Pour ajouter un canal contenant un synthétiseur, cliquez
sur Channels > Add One comme ci-dessous et choisissez un des nombreux instruments
disponibles : clips audio, clips d'automation, 3xOsc, Autogun, BeepMap, BooBass, Buzz
Generator Adapter, Chrome, Dashboard, DirectWave, FL Keys, FL Slayer, FPC, Fruit
Kick, Fruity DrumSynth Live, Fruity DX10, Fruity SoundFont Player, Sytrus,
Plucked!, SimSynth, Wasp et tant d'autres (la liste d’instruments grandit a chaque version !).

B FLSTUDID DanceWith me (Biake Reary's.. DD F

FILE DT CHAMNELS |VIEW. DPTIONS TODLS HELA |

Add one 3 More...

Clone selected Shift+Ckrl+C Browse presets

Delete selected. .. Chrl+Del ey

Mowve selecked up Alk+Up Audio clip

Move selected down Alt+Down Automation chip

Group selected... Al+s Saigd s

‘el el N T5404 bassline synthesizer
Speech synthesizer

Zip selected Alt+Z 3w Osc

Unzip all BeepMap

Restretch all BooBass

Chrome

Dashboard
Directhave

FL Keys

FL Slayer

FRC

Fruit Kick,

Fruity DrumSynth Live
Fruity Dx10

Fruity Envvelope Contraller
| Generators Fruity Granulizer

Fruity Keyboard Controller

==
ClAsen]
@ Rad E Fruity Soundfant Player
Qsrer (=) sune Fruity Yideo Flayer
MICT Cut
Rewwired
SimSynth
Sytrus

Fruity Slicer

W'asp
Wasp KT
wave Traveler
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Qu'attendre ? Le nouveau canal s’affiche dans le séquenceur pas a pas et la fenétre de
configuration de l'instrument apparait aussi. Si la fenétre de configuration est suffisamment
petite, elle apparait dans une boite de dialogue Channel Settings (3xOsc, BeepMap, Fruit
Kick, Fruity SoundFont Player, Plucked!). Sinon, elle s’affiche dans une fenétre distincte
(Autogun, BooBass, Buzz Generator, FPC, Fruity DrumSynth Live, Fruity DX10, SimSynth
Live, Wasp, Sytrus, Poizone, Sawer, Toxic Biohazard).

Comment les utiliser ? 1l est important de savoir que la plupart des instruments ont leur
propre aide. Si la fenétre de configuration de l'instrument est imbriquée dans la fenétre
Channel Settings, cliquez sur le nom du canal. Si elle est dans sa propre fenétre, cliquez sur le
menu du coin supérieur gauche.

Sons préprogrammeés (Presets)

r[:] Channel settings - BeepMap = "’MASP L]
iana rol
Presets
- - - Browse presets
PLUGIN | INS | MISC | FUNC "y Save preset zs...
Add to plugin datsbase
BeepMap

Fiano roll - Store in spare state AMP ENV

Presets

Browse presets Link all parameters...

Save praset as.., | 3 Browse parameters

Browse parameters | Smart disable

Make editor thumbnail

Detached
Help

[oL

Aide

Sons Presets. De nombreux synthétiseurs (BeepMap, Buzz Generator, Fruit Kick, Fruity
DrumSynth Live, Fruity DX10, SimSynth Live, Wasp,...) ont des sons préprogrammeés
(Presets). Dans la plupart des cas, vous pouvez les sélectionner depuis la section Presets du
menu représenté ci-dessus ou en cliquant sur les petites fleches dans le coin supérieur droit de
la fenétre (voir illustration ci-dessus a droite).

Boite de dialogue Channel Settings. Tous ces instruments ont une boite de dialogue
Channel Settings que vous pouvez afficher en cliquant sur le nom du canal, tout comme pour
les canaux d'instrument a d’échantillon. Mais comme chaque instrument est différent, tous
leurs panneaux ne sont pas les mémes comme c'est le cas pour les instruments a échantillon.
Par exemple, le TS-404 a les onglets SMP, MISC et FUNC, tandis que le BeepMap offre les
onglets INS, MISC et FUNC.
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6. Que font ces instruments ? OK, voici l'aspect des instruments. Veuillez noter que certains
de ces instruments doivent étre achetés séparément. Si vous ne les avez pas achetés, vous
n'aurez qu'une version de démonstration pour écouter leurs sons mais ces canaux ne seront
pas sauvegardés dans votre projet FL Studio. Certains instruments (et effets) de
démonstration produisent un son sifflant doux intermittent. Si vous entendez quelque
chose qui sonne comme un océan, vous avez probablement une démo chargée quelque
part dans votre projet.

a. 3xOsc (inclus). C'est un instrument simple permettant de combiner trois oscillateurs
générant chacun un son. Les sons en eux mémes ne sont pas trop excitants, mais
constituent une excellente base de départ a combiner avec les effets de I’onglet INS ou
avec d’autres plugins d'effets (expliqués dans un autre chapitre) particuliérement si vous
étes novice en synthése.

b. Autogun (inclus) est un univers de sons attendant d’étre découvert. Basé sur le moteur
de synthése Ogun et sur le processeur d’effet Soundgoodizer, Autogun contient
4294967296 presets (quatre milliards deux cent quatre-vingt quatorze millions neuf cent
soixante sept mille deux cent quatre-vingt seize), la plupart n’ayant encore jamais été
entendu par aucun homme (ou femme, il y a des filles ici ? récupérez vite leurs numéros
de téléphone ).
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| Blasting thump
Ginsu
This one has the best vibration, and
< whispery. »

o»— Preset selectors —e

c. BeepMap (inclus). Celui-ci est bizarre. Il interpréte les fichiers d’images Bitmap pour les

transformer en son; les résultats sont surprenants et réussis. C’est le type de synthé
employé par Aphex Twin pour intégrer a une piste son image qui s’affiche quand la piste
est envoyée a un analyseur de spectre.

&, WIDEN
FREQD LENGTH

Foeer: fooew FRSE feep-Map 23

LLLLERRERRERAREERTRRDEERTRRRRERTRLARERLRERRALL [¥]

d. BooBass (inclus). Un petit générateur de basse pratique du méme développeur que
SimSynth.

TREELE
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e. Chrome (inclus). Un plugin de visualisation qui vous permet de déclencher des
événements graphiques a l'aide du Piano roll, d'un contrbleur physique ou de clips
d'automation. Comprend une caméra, un sélecteur de scéne et une grande variété de
parametres de scene différents.

SCENE DBJECT PROFERTIES SCREEN
AUTO

= [ ewemance 1 | [ (o - ptprnt i |

CHROME | @ —mwe—1 | [FHR 55 Emre 08 |

B FRELDAD ECENE ' aH

| SCENE FARAMETERE GUALITY Pusnm EFFECT

|

f. Dashboard (inclus). Vous permet de créer vos propres interfaces MIDI et de commande
interne (consultez I’aide en ligne pour voir de quelles commandes internes il s’agit).

CHIL| 77} | BANH] === | === | FATCH

| Wheeld Whee1) Wheelll Wheel Wheelt) WhesH

g. FL Keys (inclus). Un simulateur de piano réaliste avec emploi optimisé du processeur et
de la mémoire.

FPL=KEYS |[F=mn

- H

NI: LPD
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Ma brillante improvisation! FL Studio a un
enregistreur permanent de 3 minutes qui capture
toutes les interprétations au clavier. Il est toujours en
service, pour que vous ne perdiez jamais une
improvisation remarquable. Voyez la fonction Tools
> Dump score log to selected pattern !

h. DirectWave (version lecteur). Un puissant échantillonneur disposant d'une section de
synthese entiérement programmable, avec tous les "plus™ habituels d'un échantillonneur.
Direct Wave peut aussi "échantillonner" (enregistrer le son) quand il est chargé comme
effet dans une piste du mixer.

i. FL Slayer (inclus). Un simulateur de guitare électrique réaliste équipé d'une section
ampli de qualité et d'un rack d'effets vous permettant de recréer un son complet de guitare
sans autres plugins.
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j. FPC (FL Pad Controller, inclus). Un plugin similaire & l'unité physique MPC d'Akai,
codé & optimisé pour la plate-forme FL Studio. FPC est une boite a rythmes
multicouche/ dynamique autonome qui facilite la création, I'édition et le changement de
Kits de batterie a la volée. FPC accepte 16 patches multicouches pour les banques A et B.
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k. Fruit Kick (inclus). Un instrument grosse caisse.

HRAX

alalals

HIn DEC — "~ A.DEC CLIGH
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I.  Fruity DrumSynth Live (démo). Un plugin synthétiseur de batterie vous permettant de
définir des "péches" de batterie et de les piloter par un clavier.

m. Fruity DX10 (démo). Un synthétiseur FM polyphonique 8 voix (ce qui signifie 8 notes a
la fois). 1l est congu pour produire des sons de haute qualité sans trop solliciter le
processeur central.

n. Fruity Envelope Controller (inclus). Vous permet de déclencher des enveloppes qui
peuvent étre associées a des parameétres de FL Studio. Comprend un éditeur d'enveloppe
similaire a celui employé dans Sytrus et FPC.

I—@ Fruity Envelope Controller {Env Cirl)




®

0. Fruity Granulizer (inclus). Donne des sons sympas, changeants, a partir de vos
échantillons.

[ 1 GRAINS

ATT HoLo 6P

EFFECTS
FAN FiD %5

TRANSIENTS
HOLD

STRRT . kEY T0 | Pitch

p. Morphine (démo) . Un puissant synthétiseur additif a l'architecture logique, souple, qui
vous permet de créer n'importe quel son. Vous pouvez faire cela directement en réglant
manuellement les harmoniques ou en prenant en entrée n'importe quel échantillon et en le
resynthétisant en une des 4 voix indépendantes.

MASTER ENVELDPE MASTER

L J1llilY . BELAY Etvens

GEGEEee®®®® -

CEFTH  RATE [T TME  STERED  FDBK  MODDETH  MOC DECAY  HCUT [T

@m0 W0 W m aK

g. Ogun (démo) peut produire des timbres métalliques et chatoyants exceptionnellement
riches, bien qu’il ne soit pas limité a ce genre. Le moteur de synthése caractéristique
d’Ogun peut générer plus de 32 000 harmoniques, modulées par des fonctions de
"placage harmonique" de haut niveau, qui donnent a I’utilisateur un contréle tonal direct.

37




Master CONtrols HODULATIEN  starting point for tonal presets
| ithor

FILTER | L7 P 185 ()
| @eﬁ}vf -n

r. Toxic Biohazard. Dispose d'un moteur de synthése hybride, combinant le meilleur de la
FM et de la synthése soustractive. Avec des filtres chauds modélisant leurs équivalents
analogiques et un jeu d'effets intégrés, Toxic Biohazard c'est a la fois la commodité, la
simplicité et une superbe qualité sonore.

S5 10D - 108 00 100
1 [

o EREFNENENER
1000 100

s. Fruity Keyboard Controller (inclus). Une commande d'automation qui ne produit
aucun son par elle-méme, mais peut étre utilisée comme bouton de commande et curseur
dans FL Studio, en affectant depuis le Piano roll ou le séquenceur pas a pas la hauteur et
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la dynamique de note a tout parameétre automatisable ou plugin de tierce partie.

o 8, RELERSE ', e !"__

'l'JI.l']l.ll']l.l']l.ll']I.l']l.ll']l

Fruity Slicer (inclus). Il vous permet de découper une rythmique et de jouer des coups
de batterie individuellement au clavier. Vous pouvez faire des breaks sympas vraiment
vite avec cet outil.

Fruity slicer

wd il w»a I3 L

L MW

S| ANIMATE  *.| PLAY TO END

FRUITY:

tummmuummJ

Fruity SoundFont Player (démo). Un instrument lecteur d’échantillon sophistiqué qui
fonctionne avec la collection SoundFont2.

W Nineteen E[IIE
PATCH BANK NAME
| 0| Nineteen
REVERE CHORUS
SEND TO == l’T SEND TO == Iﬁ_
B

BT LiL | Bunrin L

ENVELOPE 2

v. Fruity Vibrator (inclus). Vous pouvez ajouter des vibrations a vos morceaux avec

n’importe quel fichier Force Feedback (.ffe) . Ces fichiers peuvent étre créés avec I’outil

Microsoft Force Editor du kit DirectX Developer SDK.
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w. Poizone (démo) . Un synthétiseur logiciel soustractif concu pour vous donner des
résultats de qualité professionnelle, sans pour autant nécessiter un apprentissage qui
entraverait votre créativité. Le concept a l'origine de PoiZone est la création d'un
synthétiseur ayant le plus petit nombre de commandes mais fournissant une flexibilité et

des caractéristiques maximales.

e msts POZONE

¥ OPTIONS

UNISON POLY.
LINK | UNLINK] | - -

MIDI ——— L FO
swavounT | [IZEESEAMCUNT RATE  SHAPE

', £ cuTore
LicutorF o)

X. Plucked! (fourni) Synthétiseur dédié aux sons d’instruments a cordes: guitare, harpe,
mandoline, etc.

y. Sawer (demo) est un synthétiseur & modélisation vintage qui peut ressortir au mixage
avec des sons bien articulés et pleins de punch.
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z.  SimSynth Live (démo). Synthétiseur numérique trés complet. Utilisez ce bébé en vue de
créer de gros sons analogiques pour vos titres de dance et de trance.

ADAS il ||

FOCHORUS %

aa. Slicex (inclus — producer edition et supérieure) utilise des algorithmes avancés de
détection rythmique pour découper les morceaux/échantillons de percussion en segments
et les rendre indépendamment jouables depuis le Piano roll ou un contréleur. Si le fichier
audio contient des données de tranche/région, celles-ci seront employées
automatiquement a la place des algorithmes de détection rythmique. Slicex offre la
lecture, le reclassement des tranches et des possibilités de time-stretch optimisées pour
les boucles de batterie.

41




42

(master panel [N A000ATION  (AVERING — rLICE> )

= £ 0 Kb shortcuts
LT e e © e bau )
Gr‘ticulation |panel A mncoieror PAN O CUTREST ] SPEED smrj
| Q2045608 | Wm0 W Mooy |wGoY (RRND
e r |
L ae Os
HuER e

seeen ) mTm ; ( >
Ls:w dg i IS ‘:.. ( us
rV_Va\?e editor BB X T et
s EE 1005 DECK 15 vaphop 0z

#1 o 47 ifieier 43 larker #4
|1

i

LLA L
FIUTERN  OFF i (a2 &

bb. SynthMaker (inclus — producer edition et supérieure). Accrochez-vous ! SynthMaker

CC.

est une application de programmation audio servant a créer des instruments et effets
virtuels sans avoir a écrire de code basique. Les instruments et effets créés dans
SynthMaker peuvent étre utilisés dans FL Studio comme plugins "natifs" et partagés avec
d'autres utilisateurs de SynthMaker.

IEmmeveeses m]

Sytrus. Sytrus est le synthétiseur le plus polyvalent de I'arsenal FL Studio, combinant
modulation de fréquence (FM), modulation en anneau (RM), modélisation de cordes
pincées et synthése soustractive, et disposant d'un puissant éditeur d'enveloppe. Le synthé
comprend un mode unisson éditable et performant et une section d'effets compléte.
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dd. TS404 (compris). Une remarquable machine "techno" pour la création de lignes de

synthé et de basse, au son similaire a celui de la classique TB-303 (regardez "more" dans
la fenétre contextuelle Add one).

ee. Wasp (démo). Autre synthétiseur numérique trés complet. Celui-ci est mieux adapté
pour la création de sons rapides, orientés techno (d’ou son nom).
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ff. WaveTraveller (inclus). Crée des scratches réalistes avec un contr6le total sur les plus
petits détails !

VOC_ScratchinSurf.wawv

UUE v
mtmnﬁe: Ir( TR ORI A

gg. Layer (inclus). Ce n’est pas vraiment un instrument, mais c’est sympa. Il vous permet de
créer un canal d’instrument pour piloter d’un coup plusieurs autres canaux d’instrument.

I IE‘ Channel settings - Layer

o= B

Root note: C5

hh. MIDI Out (inclus). Ce n’est pas non plus un instrument. 1l vous permet d’envoyer un




signal de commande MIDI a un appareil MIDI externe (ou interne).

CHANNEL 1| BANK --- | ---| PORT g

PATCH === |[(none) |

.Page 1

o e e e

ini

ii. Speech Synthesizer (inclus). C’est un assistant pour ajouter des lignes vocales
synthétisées a vos morceaux.

jj- Autres. Il existe d'autres instruments, voir l'aide de FL Studio (F1).

Et encore plus d’instruments ! Avec le Fruity Wrapper, vous pouvez en plus ajouter
n’importe quel plugin synthétiseur VST ou DX téléchargé ou acheté. Dans le menu
Channels, sélectionnez 1. Add One > 2. More. Cela produira une liste des plugins
disponibles comme ci-dessous. VVous pouvez choisir n’importe lequel de ceux sous I’en-téte
Fruity Generator Plugins en double-cliquant dessus. Le “F” encadré prés du nom de plugin
identifie un “Favori” qui apparait dans le menu Add One (“ajouter”) ci-dessous. Si vous avez
ajouté un nouveau plugin a votre dossier de VST (F10 File settings dans FL Studio), vous
pouvez devoir 3. Actualiser (Refresh) et 4. Analyser rapidement (Fast scan) pour voir votre
nouveau plugin apparaitre dans la liste ‘More...".

FAson JI=1d
FLE EDT CHANELS VIEW OPTIONS T00LS HELP

Drop th1 o @ Add ore 2-"";1'2""5--- Select generator plugin
|  Clone selected Shift+CEr|+C Browise presets - DXi plugins -~
Delete selected. .. Crl+Del Dreamotation D
S 1L FL Studio D
Move selected up Al+Up IL Multi FL Skudio D
Move selected down Alb+Down Aukomation clip IL Sybrus D
5 | - Fruity generator plugins
Group selecked. . A+ b . [F] 3x Osc
B Sélecteur de favori < se=ovan
S iz [F] BooBass
Zip selected alk+2 TG [F] Chrome
Urnzip &l Alt+U [E] Dashboard
Besnlic [E] Directwave
BooBass [F] FL Keys
Buzz Generakor Adapter [E] FL Slaver
[F] Taxie
0} S JRefresh
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8. Plugins VST et DX. Vous avez peut-étre remarqué le Fruity Wrapper dans la liste de
plugins ci-dessus. Le wrapper n'est pas a proprement parler un instrument mais procure
I'interface entre FL Studio et les plugins VST ou DXi. Si vous double-cliquez sur un des
plugins VST, il ouvrira automatiquement le Wrapper pour vous. VVous pouvez remarquer que
certains plugins d'instruments (et d'effets) ne disposent pas de leur propre interface, voir le
plugin gratuit DX10 ci-dessous. Il utilise I'interface générique du “wrapper”. Les autres ont
une interface d'aspect plus professionnel, comme Poizone.
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9. Les autres plugins VST. Quid des autres plugins VST dans la liste ? Ce sont soit des
1 2

fﬁéfﬁhwmum
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synthétiseurs, soit des effets (FX) (nous
expliquons comment les utiliser plus loin en
section Mixage & Effets). Les VST sont
contenus par le “Wrapper” FL Studio. 1 =
Menu Wrapper. 2 = Réglages de plugin (utiles
pour régler des sorties multiples ou mater les
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10.

11.

12.

plugins récalcitrants!). 3 = Sélecteur de preset. 4 = Fermer I’interface. Il n’y a
malheureusement pas de moyen pour que FL Studio différencie plugins d'effets et de synthés,
aussi devez-vous mémoriser qui fait quoi. Si vous essayez d’ouvrir un plugin VST et
n’obtenez qu’un message d’erreur et le wrapper vide, il s’agit sans doute d’un plugin d'effet
(FX).

Faut-il enregistrer les plugins de démo pour les utiliser ? Nous garantissons la gratuité a
vie des mises a jour du programme par la vente de quelques plugins supplémentaires a nos
clients fideles, aussi oui, dans certains cas, vous devez les enregistrer afin d’en déverrouiller
toutes les fonctions. Ainsi, vous soutenez non seulement Image Line Software mais aussi
toute la communauté FL Studio. Consultez le site internet http://flstudio.image-line.com pour
plus d'informations sur I'endroit ou envoyer votre argent si durement gagné.

Ou puis-je en trouver d’autres? Il existe des centaines de plugins de synthétiseurs
disponibles au téléchargement. Certains sont gratuits, d’autres payants. Recherchez les
bonnes affaires sur http://flstudio.image-line.com ou http://www.image-line.com. S'il est un
site a aussi mettre dans vos favoris, c'est bien http://www.kvraudio.com - un site énorme avec
des détails sur tous les plugins VST que vous pouvez vouloir (les nouveaux plugins VST
doivent étre placés dans le dossier partagé Program Files\Image-Line\ VST de votre disque
dur).

L’arpégiateur (Arpeggiator). Maintenant que nous avons présenté les instruments synthés,
nous pouvons vous en dire plus sur la section Arpeggiator de la boite de dialogue Channel
Settings. Ouvrez un canal de synthétiseur (SimSynth Live, par exemple) et ouvrez I’onglet
FUNC de la boite de dialogue Channel Settings. Cliquez sur la fleche orientée vers le haut
et sélectionnez un accord. Placez-vous a présent dans un nouveau Pattern, ajoutez une note
SimSynth unique et appuyez sur Play. A la place de la note unique, vous entendez la
répétition d’un arpége. Cool, non ? Vous pouvez obtenir plus d’informations sur ce sujet dans
I’aide en ligne.

Ma brillante improvisation! FL Studio a un
enregistreur permanent de 3 minutes qui capture
toutes les interprétations au clavier. Il est toujours en
service, pour que vous ne perdiez jamais une
improvisation remarquable. Voyez la fonction Tools
> Dump score log to selected pattern !
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|E| Channel settings - DreamStation DXi |:|
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L’Arpeggiator fonctionne mieux quand vous
jouez de linstrument hébergé par le canal
depuis un contrdleur MIDI, comme celui que
j'ai dans les mains. Géniaaaaaal !

Ne vous privez pas les gars ! Il vous faut tous ces générateurs.
Raclez les fonds de tiroir et achetez-les dés que possible. Celui qui
démarquera sans doute le plus vos pistes est Sytrus et tant que vous
y étes, n'oubliez pas Maximus, ce plugin Maximizer déchire !
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13. Speech! Oui, vous avez bien lu. Vous pouvez maintenant converser avec FL Studio gréace a la
prise en charge intégrée de la synthese vocale. Son acces le plus simple consiste & regarder
sous “speech” dans I’explorateur d’échantillons, et a faire glisser un des fichiers qui s’y
trouvent dans le séquenceur pas a pas. VVous obtiendrez une fenétre de dialogue comme ci-
dessous. VVous n'avez qu'a remplacer le texte, choisir une personnalité, un style, une vitesse
(rate), et une hauteur (pitch). Cliquez sur le bouton “listen” pour écouter comment cela sonne.
Quand vous avez fini, pressez la “coche” pour ajouter un canal d’échantillon. Vous pouvez
aussi glisser un fichier de speech dans un canal Granulizer, Fruity Scratcher ou Fruity Slicer.
Amusez-vous.

]| = Browser [x]
= i1 oren
Pads

Percs
RealDrumkits

Speech properties [x]

Text

every cloud has & silver lining| Listan

= 1st_listen
~ Activate
- AllYourBase
- alphabet_soup
- AreYouReady
= Arpegiator
- Barty1
- Barty2
- Bicycle
- bump
- Burning_ears
- CantHoldMeBac)/
= Check\'ourﬂylily
~ chopper
- clouds ‘
- ComeOnDJ
= countdown

Yoice
Personality Tipsy
Style Random

Mode Mormal

Rate Pitch D EE /

Vous pouvez avoir a écrire certains mots bizarrement (en
phonétique) pour avoir le son voulu... Vous pouvez avoir un
rendu chanté en fixant 'augmentation de hauteur (en demi-
tons) entre parenthéses apres les mots. Essayez de saisir

“all your(2) base(3) are(2) beelong to us” dans la fenétre ci-
dessus (utilisez un stvle monotone).
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MIXAGE & EFFETS

IMPORTANT : Ce guide est un guide de prise en main général commun a toutes les éditions de
FL Studio. Certaines fonctions n'existent toutefois que dans certaines éditions. FL Studio
Fruityloops Edition n'a pas les fonctionnalités de curseurs de réglage de piste. Veuillez consulter
notre site http://flstudio.image-line.com pour connaitre les conditions de mise a niveau.

Une grande caractéristique de FL Studio Producer Edition est la fenétre Mixer. De la, vous
pouvez mixer 99 pistes “ordinaires” et méme les associer pour créer des groupes de mixage
complexes. Respirez un grand coup !

Une des meilleures fonctions du mixer est la possibilité d'ajouter des effets aux sons venant des
canaux. Ces effets vont de simples changements de volume a des effets plus sophistiqués
comme chorus, reverb, phaser, delay, flange et EQ, entre autres (vous pouvez aussi ajouter des
instruments, mémos, contrbleurs, moniteurs et plein de choses utiles !).

Ouvrez la fenétre Mixer. Appelez la fenétre Mixer en pressant F9 ou en allant sur View >

Mixer. Vous obtiendrez une fenétre telle que celle-ci... __, ..
Défilement des Emplacements

Piste M!"E 3| o8 o5 o6 = =8 = e e S S plugins
Master : d'effet
Pistes ‘H
de mixer Réglages
de piste

Que voyez-vous ? A gauche se trouvent les pistes de mixer standard. Vous avez une piste
Master (M dans l'en-téte), 99 pistes standard, 4 pistes de départ (Send) dédiées et 1 piste
sélectionnée, bien que toute piste de mixer puisse servir de départ. Vous pouvez cliquer sur le
bord du mixer et le tirer pour afficher les 99 pistes de mixer (si votre écran est assez large !).
Sinon, un curseur situé dans le coin supérieur gauche du mixer permet de faire défiler les pistes.
La piste Master est sélectionnée par défaut (bien que ci-dessus la piste 1 soit sélectionnée comme
indiqué par la couleur plus claire). Chaque piste peut accueillir huit plugins d'effet (FX) (en haut a
droite). Quand vous sélectionnez une autre piste (en cliquant dessus), la banque d'effets affiche
les effets qui y sont chargés.

50




®

Les panneaux de commandes de piste affichent quelques propriétés de chaque piste sélectionnée.
Les réglages de volume et de balance stéréo sont associés aux commandes correspondantes sous
chaque piste (celles-ci sont indépendantes des commandes pan et vol des canaux d’instrument et
viennent en complément, page 10). Les autres éléments du panneau de commandes de piste sont
le correcteur paramétrique 3 bandes (EQ ou égaliseur), la commande d““amplitude” stéréo, le
commutateur de phase, I’inverseur G/D et un grand indicateur de niveau sonore (affichant le
volume de sortie de la piste).

Commutez les plugins On et Off / Mixage avec et sans effets. Cliquez sur la diode verte a
droite de chaque plugin pour le commuter on et off. Essayez cela pendant que la boucle est
reproduite pour entendre la différence. Vous pouvez aussi tourner le potentiometre a coté de la
diode pour mixer le son *“sec” (sans effet) et le son avec effet.

Sélectionnez les plugins. Pour ajouter de nouveaux plugins, cliquez sur la fleche descendante de
I’emplacement d’effet (1) ou vous voulez ajouter le plugin et choisissez dans la liste des favoris
(sous le 2) ou choisissez Select More (2) pour accéder a la liste entiere et configurer vos favoris.
Si vous avez ajouté un nouveau plugin a votre dossier de VST (F10 File settings dans FL Studio),
vous pouvez devoir 3. Actualiser (Refresh) et 4. Analyser rapidement (Fast scan) pour voir votre
nouveau plugin apparaitre dans la liste ‘More...".

Mixer - Insert 1

Select effect plugin B
[E] Fruity 7 Band EQ =
\ [F] Fruity Balance
: ‘ : [F] Fruity Bass Boost
lSte d €s favo ris [F] Fruity Blood Cverdrive
EQUD [E] Fruity Center
’ Fruity Chorus .
Fruity Balance G
e [E] Fruity Compregsor 3 P{I|S
3 AT =] Fruity Delay z L+
IR [F] Fruity Fast LP sélegtionnez
; Fruity Blood Overdrive [E] Fruity Filker iri
Smart disable Bl Eentien [E Fru!ty Flange.r
) [E] Fruity Free Filter
,,,,,,,, B Maove up Fruity Charus [E] Fruity Monokiller
Move down Fruity Compressar [ Fruity Mute 2
3 Fruity dB Meter [E] Fruity Phase Inverter
B [ e [ e e -4 ) [E] Fruity Phaser
|_ E RS [E] Fruity Reeverb
Fruity Delay 2 [F] Mayigus é} —® Fa | (recommended)
Fruity Delay Bank ﬁ?
Nouveau pl

Réglage des plugins. Faites un clic gauche sur le nom du plugin pour ouvrir et fermer sa fenétre
de réglages. Certains plugins présentent une interface générique comme Fruity Reverb. D’autres
ont des commandes plus originales (comme Fruity Limiter). La plupart des plugins possédent
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leur propre rubrique d’aide comme ci-dessous, nous ne nous attarderons donc pas ici sur I'emploi
de leurs commandes. Pourquoi ne pas jouer avec tous pour voir ce qu'ils font ?

Les effets ont aussi des Clic gauche ici
presets ! pour ouvrir I'effet

Mixer - Master
55| | BE)| | 50| | | | S| | 5| | 56| | 58| |56 | 56| | HS)| | 66| | 5| | 74| 58| (58 IN [none]
Fruity Fast Dist

Select

Presets

R R )

Browse presets
Save presef as..,

Browse parameters

Rename. ..
Smark disable

_'__'__J'__I'__I'_'_,'_'__'__'__'__'__'__'__'__'__'_

Cliquez ici pour l'aide
en ligne

Cliquezici pour
activer/désactiver I'effet

Transmission de sons au mixer. La case en haut a droite du panneau Channel Settings (ci-
dessous, n’oubliez pas le clic gauche sur un bouton de canal pour ouvrir cette fenétre) est un
"départ"” de piste de mixer. Les effets placés sur la piste Master du mixer sont appliqués a tous les
sons du morceau. A I’inverse, les effets des pistes 1-99 du mixer ne sont appliqués qu’aux
échantillons et aux synthétiseurs pour lesquels cette piste de mixer est sélectionnée dans leur
boite de dialogue Channel Settings.

' |E| Channel settings - Dream5Station DXi

Envoi ala
A= A piste de
AN~ WL FITEH ¥ mixer 2

A quoi servent les pistes de départ (Send) ? A économiser et & plus de commodité ! Il existe 4
pistes de départ ayant pour entrée d'autres pistes du mixer plutdt que des canaux d'instrument.
Supposons que vous souhaitiez appliquer la méme Fruity Reverb a la guitare et a la batterie, mais
avec en plus un Fruity Delay sur la guitare et une correction tonale sur la batterie. Facile.
Envoyez le signal de batterie a la piste ordinaire 2 du mixer ou vous avez placé le correcteur
(EQ). Envoyez le signal de guitare a la piste ordinaire 3 du mixer ou vous avez placé le Fruity
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Delay. Placez la réverbération sur la piste de départ (Send) 1 et tournez le potentiométre de départ
(Send) 1 des pistes de mixer 2 et 3 pour envoyer le signal de sortie de ces pistes a la piste de
départ 1. La méme réverbération est a présent appliquée a la guitare et a la batterie et vous n’avez
utilisé qu’un seul plugin de réverbération. Les potentiométres de départ (Send) se trouvent sous la
piste recevant I'entrée pas celle de départ. Une fleche descendante orange indique la piste
source. Note : comme n’impote quelle piste de mixer peut étre envoyée a n’importe quelle autre,
vous pouvez avoir plus de 4 pistes de départ.

C’est la piste source
gui envoie l'audio a 2
autres pistes (une
piste ordinaire et
une piste de départ).

Pistes de départ
dédiées.

Ces deux pistes recoivent I'entrée, notez les positions de commandes
donnant le volume du signal entrant, cliquez sur la fleche montante pour
afficher/masauer les commandes de départ

Modification de I’ordre des plugins. L’ordre dans lequel vous ajoutez les plugins d’effets
détermine leur ordre d'application sur le signal. Représentez-vous cela comme suit — le signal
entre par le haut de la colonne d'effets et sort par le bas. Donc un Delay au dessus d'une Reverb
signifie que le Delay baigne dans la Reverb. La Reverb avant le Delay signifie que la queue de
Reverb est hachée et retardée. Pour faciliter I’établissement de I’ordre des effets, FL Studio est
équipé d’une fonction trés simple permettant de déplacer un effet vers le haut ou vers le bas dans
la chaine des effets. Un raccourci rapide consiste a placer le curseur de votre souris sur
I'emplacement de I'effet FX et & tourner la molette de votre souris. Vous n‘avez pas de
molette ? Cliquez sur le menu FX et pressez "'u" ou "'d"" au clavier pour déplacer |'effet.
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Placez le pointeur
de votre souris sur
le nom de |'effet et
tournez la molette

* 7
=) Fruity Delay
- Fruity Reeverb

de la souris OU
cliguez avec le
bouton gauche et
pressez "u" ou "d"

Que font les différents plugins ? Comme indiqué précédemment, une aide en ligne est
disponible pour chacun des plugins FL Studio; voici néanmoins un bref apercu de leurs
possibilités -
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Buzz Effect Adapter. Cet adaptateur permet de charger n'importe quel effet Buzz Machine.
FL Studio est livré avec certains déja installés, mais vous en aurez plus sur
http://www.BuzzMachines.com.

Edison. Outil entiérement intégré pour I'édition et I'enregistrement audio. Edison se charge
dans un "slot" ou emplacement d'effet (dans n'importe quelle piste de mixer) et de la il
enregistre ou reproduit I'audio (voir page 75 pour plus d'informations).

EQUO. Banque de 8 égaliseurs graphigques avec morphing entre banques, particulierement
adaptée a l'automation.

Fruity 7 Band EQ (inclus). Correcteur (“égaliseur") pour votre son (comme sur la chaine
stéréo de papa a la maison).

Fruity Balance (inclus). Permet de changer le panoramique et le volume pendant un
enregistrement live.

Fruity Bass Boost (inclus). Accentue les basses pour un super gros son.
Fruity Big Clock (inclus). Affiche une énorme horloge indiquant le temps de lecture écoulé.
Fruity Blood Overdrive (inclus). Applique une distorsion sur les canaux sélectionnés.

Fruity Center (inclus). Supprime en temps réel le bruit lié¢ aux composantes continues (DC
Offset).

Fruity Chorus (inclus). Ajoute un doux effet de chorus.
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Fruity Compressor (inclus). Uniformise la dynamique du signal. De nombreux producteurs
appliguent aujourd’hui une compression massive pour obtenir ses sons de batterie
particuliers...

Fruity dB Meter (inclus). Affiche un grand indicateur de niveau.

Fruity Delay (inclus). Applique un véritable écho (pas une simple répétition d’échantillons
comme I’écho du canal).

Fruity Delay 2 (inclus). Fruity Delay de nouvelle génération. Ajoute panoramique et autres
effets.

Fruity Delay Bank (inclus). Banque de 8 banques identiques, chacune pouvant alimenter la
suivante dans la chaine pour créer des effets complexes de delay et de filtrage.

Fruity Fast LP (inclus). Filtre passe-bas sollicitant peu les ressources du processeur
(coupure et résonance) .

Fruity Fast Dist (inclus). Un effet remarquable de distorsion Iégére ne sollicitant quasiment
pas le processeur.

Fruity Filter (inclus). Filtre a coupure et résonance sollicitant davantage les ressources du
processeur.

Fruity Flanger (inclus). Si vous demandez, c'est que vous ne l'avez pas entendu. Tres
apprécié des guitaristes, cet effet de type LFO donne une sensation sympa a tout morceau.

Fruity Flangus (inclus). Un effet trés utile, pour enrichir le panorama stéréo de vos
instruments, ajouter un chorus de haute qualité et simuler une synthése a l'unisson.

Fruity Formula Controller (inclus). Contrdleur interne original que vous pouvez coupler a
d'autres boutons rotatifs et curseurs dans FL Studio. Plus d'informations dans la section
Automation...

Fruity Free Filter (inclus). Encore un autre filtre - un classique 12 dB a la place d'un filtre
variable comme Fruity Filter (qu’est-ce que cela signifie ?).

Fruity HTML Notebook (inclus). Ajoute des notes a votre boucle, au format html, ou bien
votre propre page web !

Fruity Love Philter (inclus). Le plus puissant plugin de filtrage de FL Studio. Consiste en 8
unités de filtrage identiques, chacune capable d'alimenter la suivante dans la chaine. Crée des
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effets complexes de delay, gate et filtrage.

Fruity LSD (inclus). Permet a FL Studio d'accéder au synthétiseur DirectMusic fourni avec
DirectX 8. Notez que DirectX 8.0 ou ultérieur doit étre installé sur votre machine. LSD agit
comme un périphérique MIDI externe, qui peut étre piloté depuis un canal de générateur
MIDI Out (voir la section précédente sur les générateurs).

Fruity Limiter (inclus) . Maximiseur, compresseur et limiteur simple bande.

Maximus Multiband Maximizer (démo). Compresseur-limiteur 3 bandes. Puissante
maximisation. Personne ne devrait participer a la guerre du volume sans en étre équipé ©.

Fruity Multiband Compressor (inclus). Compresseur stéréo 3 bandes a filtres RII
ButterWorth ou RIF a phase linéaire pour diviser le signal entrant en trois bandes en vue du
traitement. Une fonctionnalité de limiteur est aussi incluse.

Fruity Mute 2 (inclus). Réduit au silence (Mute) les canaux pendant I’enregistrement live.

Fruity Notebook (inclus). Conservez vos notes ici ! C’est le plugin utilisé dans les boucles
de didacticiel fournies avec le logiciel.

Fruity PanOMatic (inclus). Utile pour panoramiquer progressivement le son de part et
d'autre.

Fruity Parametric EQ (inclus). Correcteur paramétrique créé pour FL Studio. Les
correcteurs ordinaires ne permettent de régler que le niveau de bandes de fréquences
préétablies, mais avec un correcteur paramétrique, vous choisissez la bande de fréquences a
corriger.

Fruity Parametric EQ 2 (inclus). Plugin de correcteur paramétrique 7 bandes sophistiquée
avec analyse spectrale. La fréquence et la largeur de chaque bande est réglable, ainsi que le
type de bande. Utile lorsque vous avez besoin d'une correction précise.

Fruity Peak Controller (inclus). C'est un autre contrbleur interne. VVous en saurez plus en
section Automation ci-dessous.

Fruity Phase Inverter (inclus). Inverseur de phase stéréo (gauche et droite).
Fruity Phaser (inclus). Comme un Flanger, mais encore plus sympa.

Fruity Reeverb (inclus). Effet de réverbération bien plus agréable que celui obtenu depuis la
boite de dialogue Channel Settings.
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Fruity Reverb 2 (inclus). Nouveau plugin de réverbération amélioré avec un son de plus
haute qualité et plus de commandes que la réverbération d'origine.

Fruity Scratcher (inclus). Chargez un échantillon et scratchez-le a mort. Ce plugin est plut6t
un instrument car il produit du son par lui-méme et ne se contente pas de modifier un canal.

Fruity Send (inclus). Placez ce plugin entre deux autres plugins pour diviser le signal et
I'envoyer a un des quatre canaux de départ (Send ) d'effet.

Fruity Soft Clipper (inclus). Filtre limiteur doux peu gourmand en puissance de traitement.
Il vous permet d'éviter I'écrétage et la distorsion par une légére compression du signal entrant.

Fruity Spectroman (inclus). Ouvre un analyseur de spectre pour visualiser la répartition
spectrale des sons de votre piste.

Fruity Squeeze (inclus). Plugin de diminution de résolution (bits), distorsion et filtrage.
Fruity Squeeze ajoutera un caractere tonal rapeux aux sons entrants et est particulierement
efficace quand il est appliqué aux boucles de batterie.

Fruity Stereo Enhancer (inclus). Apporte une tres belle séparation stéréo et d'autres effets.

Fruity Stereo Shaper (inclus). Version plus sophistiquée du Stereo Enhancer avec décodage
MID/SIDE (attention, celui-ci va vous tordre la téte !)

Fruity Vocoder (inclus). Un vocoder sophistiqué avec de nombreux parameétres réglables et
une latence nulle (c'est-a-dire que les sons traités ne sont pas “en retard”). Cet effet exige
beaucoup du processeur de machines plus lentes mais a une précision et des fonctions
uniques.

Fruity WaveShaper (inclus). Effet de distorsion d'onde qui associe les valeurs d'entrée et de
sortie selon un graphique basé sur des courbes flexibles a "points d'inflexion".

Fruity X-Y Controller (inclus). Encore un autre contr6leur interne sur lequel vous en saurez
plus en section Automation ci-apres.

Gross Beat (démo). Effet de manipulation/réorganisation temporelle.
Maximus (démo). Plugin compresseur/limiteur avec maximisation.

Soundgoodizer (inclus). Plugin gratuit de maximisation et d’optimisation du son.

57




®

Presets d'effets. Si un plugin intégre des presets, vous pouvez y accéder depuis la section
presets du menu des effets (voir ci-avant), ou avec les petites fleches (coin supérieur droit de la
fenétre de plugin) comme pour les plugins de synthétiseur. Vous pouvez créer vos propres presets
en cliquant sur Save preset. En faisant ainsi, FL Studio enregistre les positions de toutes les
commandes de plugin pour que vous puissiez retrouver exactement le méme son d’effet par la
suite. Si vous avez sauvegardé vos presets dans le répertoire que FL Studio suggere, ils
réapparaitront dans le menu sous presets.

Obtenir de nouveaux plugins. Une remarquable sélection de plugins d’effets est fournie avec
votre ensemble FL Studio. Mais des développeurs en créent sans cesse de nouveaux et vous
pouvez vous en procurer un grand nombre sur Internet. Certains sont gratuits, d’autres vous
colteront de I’argent. Surfez sur le web (kvraudio.com est un excellent endroit pour commencer)
et voyez ce que vous pouvez trouver ! L'aide en ligne (pressez F1 dans FL Studio) contient des
guides pas a pas détaillés sur la fagon d'installer et d'utiliser ces plugins de tierce partie.

A propos du processeur. "WAOUHH ! Je peux utiliser autant de plugins que je veux ?!?" En
fait, non. Chaque plugin utilise une certaine quantité des ressources du processeur de votre
ordinateur; certains plus que d’autres. Le nombre de plugins utilisables avant que votre
processeur ne soit a bout de souffle dépend de sa cadence (ces fameux Mégahertz...) mais aussi
de la quantité de mémoire vive installée. Il n’existe pas de formule pour calculer le nombre de
plugins que peut gérer votre machine, mais si le son saccade juste aprés avoir ajouté un plugin,
c’est que vous en avez trop. N’oubliez pas non plus les canaux de départ (Send). lls peuvent
aider a réduire le nombre total de plugins activés. N'oubliez pas non plus que régler la taille de la
mémoire tampon (Buffer Length dans les réglages audio (F10 : Audio settings) peut souvent
résoudre vos problémes de processeur (voir la section “Premier lancement” en page 7).
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ENREGISTREMENT LIVE DES MOUVEMENTS (Automation)

Saviez-vous que vous pouvez enregistrer tous les mouvements que vous faites faire a n’importe
guelle commande ? Cela s’appelle une “automation” et c’est la clé pour donner de la vie a vos
morceaux. Ouvrez la boite de dialogue Channel Settings pour un simple instrument de canal
(comme une caisse claire) et cliquez sur I’onglet INS.

|E| Channel settings - FL Studio Rocks ... |:|

[smr s [misc [runc
Cliquez sur [pAN woL |cuT [Res [PiTcH

I'onglet INS

e ™s | Envelope

| | Regardez ce
A~ [ruLFo [Filter bouton
&= bouger!

|| .llﬂll! HODY
(;“ .|| [Fast LP
DEL AHT SFD

| Elobal

TATTAITAR,

L

1. Sélectionnez un pattern d’automation. OK, ceci est important. Une automation est vite mal
placée aussi vaut-il mieux I'enregistrer entiérement dans un seul Pattern, c'est pourquoi nous
en avons pré-baptisé un “Main automation” en Playlist de pistes de blocs (zone inférieure).
Placez ce Pattern dans la Playlist au début du morceau pour lire I’automation (si vous le
placez dans la Playlist des pistes de clips (zone supérieure), vous verrez I’automation dans le
clip. Quand vous maitriserez mieux tout cela, vous pourrez déroger a cette regle, mais pour le

moment faites au plus simple. N'oubliez pas de choisir le bon

Pattern ET d'activer le mode
d'enregistrement d'automation ! (clic
droit sur le bouton d'enregistrement

¥ Automation
pour cocher). Peu importe que les

v Audio autres soient aussi cochés. 5
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2.

Enregistrement d’une automation. La chose la plus simple a faire est de créer un nouveau
flp (File > New), d'y déposer quelques boucles de batterie, de placer le morceau en lecture et
de vous entrainer a jouer avec les potentiométres PAN et VOL du canal de la caisse claire
(par exemple). Lorsque vous pensez avoir un réglage intéressant, assurez-vous que le
Pattern d'automation principal est sélectionné et que I'enregistrement d'automation est
activé dans le menu obtenu par clic droit sur le bouton d'enregistrement, puis cliquez sur le
bouton d’enregistrement représenté ci-dessous. VVous pouvez d'abord entendre un décompte
de trois temps, si la diode de décompte 321 est allumée. Lancez le morceau et appliquez vos
fameux réglages. Le morceau est lu une fois puis s’arréte. Désactivez I’enregistrement et
appuyez sur Play (en mode Playlist avec votre Pattern dans la Playlist). Vous venez
d’enregistrer votre premiere automation !

Mode de morceau joué Bouton d'enregistrement

deouiila Plavlist /
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Réduisez la mémoire tampon. Si vous avez noté un retard entre vos réglages et la réponse
de FL Studio, vous pouvez devoir baisser la taille de votre mémoire tampon (pressez F10 et
sélectionnez I'onglet Audio). Plus le curseur est bas, plus la réponse de FL Studio est rapide.
Mais ne choisissez pas une valeur trop faible sans quoi le son risque d’étre haché (Section
“Voyons ce qui s’affiche a I’écran ? ).

Note importante. Quand I’enregistrement est activé et la boucle en lecture, bouger un bouton
rotatif supprime tous les mouvements précédemment enregistrés entre ce point et la fin du
morceau. Cela peut étre frustrant, si bien qu’il est en général préférable de définir
approximativement une automation puis d’affiner les réglages dans I’éditeur d’événements
(Event Editor) décrit en section suivante.

Que pouvez-vous enregistrer ? Les réglages de la plupart des boutons rotatifs et curseurs
peuvent étre enregistrés dans une automation, y compris ceux des plugins. Certains ne
peuvent cependant pas I'étre. Le moyen le plus simple pour connaitre les réglages
enregistrables consiste a faire glisser le pointeur de la souris sur une commande et & observer
la barre d’information. Si des témoins rouges s’affichent, alors le réglage peut étre enregistré
dans une automation.

Ou sont mes données ? Toutes les automations sont enregistrées dans le Pattern actuellement
sélectionné. Pour les voir dans le contexte, placez le clip du Pattern dans la zone de piste, un
mini-graphique s'affichera.




§ FLSTODD GettingStarteas | BEE

Description FILE EDIT CHAMNELS VIEW OPTIONS TOOLS HELP Points rouges

| Channel panning

Plugins. Vous pouvez enregistrer une automation de
commandes pour la plupart des plugins, mais pas pour
tous. Faites des essais. Consultez la section sur
I'enregistrement des notes et automations dans le manuel
en liane (pressez F1 dans FL Studio).

Le conseil de LemonBoy pour I'automation...

1. Vérifiez toujours quel est le Pattern sélectionné avant d’enregistrer I'automation.
L'automation sera enregistrée dans le Pattern sélectionné.

2. Faites un clic droit sur le bouton d'enregistrement pour vérifier que Automation, Score
(notes) ou Audio est coché, selon ce que vous voulez enregistrer.

3. Organisez votre morceau comme vous le voulez avant de commencer
I'enregistrement de I'automation. C’est beaucoup plus facile que d’essayer d’aligner
I'automation sur la structure du morceau. Il vaut mieux enregistrer I'automation sur un
morceau existant

4. Sauvegardez toujours une copie de votre projet avant d’enregistrer une automation.
Vous pourrez ainsi retrouver une copie intacte de la boucle si 'automation n’est pas
réussie ou si vous changez d’avis.

5. Sauvegardez régulierement votre projet lorsque vous enregistrez des automations.
Pressez Ctrl+N pour rapidement sauvegarder une « nouvelle » copie de votre projet.
Cela ajoute le suffixe 1, 2, 3 etc a chaque sauvegarde. Ainsi, si vous faites une erreur et
effacez certains événements, vous pourrez toujours récupérer n’importe quelle version
précédente.

6. Utilisez un contréleur MIDI externe pour vous simplifier la tache (voir la section
consacrée aux contrdleurs externes pour plus d'informations !).
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L’EDITEUR D’EVENEMENTS

A moins d'étre un vrai pro et d'avoir une mémoire tampon & 0 ms, vous ne serez peut-étre pas
totalement satisfait par vos automations. C’est la que I’éditeur d’événements entre en jeu. A
chaque fois que vous bougez une commande durant I’enregistrement d’une automation, le
nouveau réglage est sauvegardé comme "Evénement" associé a cette commande et a cet instant
dans la boucle. Gréace a I’éditeur d’événements, vous disposez d’un contrdle total sur la fagon
dont le son est modifié durant la lecture. NOTE : sous le menu Edit, vous trouverez une option
pour convertir les données d'événements en clips d'automation. Cela permet d’exporter
I’automation & un format directement modifiable dans la Playlist plutdt que dans I’éditeur.

1.
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Enregistrez une automation sur un potentiomeétre en particulier. Par ex. le potentiométre
PAN sur I'échantillon de caisse claire. Supposons que vous l'avez fait en section précédente.

Arrétez FL Studio et ouvrez I’éditeur d’événements. Aprés clic droit sur le potentiométre
automatisé, sélectionnez Edit Events dans le menu contextuel. La fenétre affichée ressemble
a celle de I’éditeur graphique déja décrit, sauf que ce graphique permet de contréler le réglage
d’un bouton rotatif ou d’un curseur en un point précis du morceau (OK, c’est en fait un peu
plus compliqué que ¢a. VVous vous rappelez quand nous vous avons dit de conserver toutes
vos automations dans un méme Pattern (Pattern 2) a placer une fois au début du morceau ? Si
vous avez bien suivi ces consignes, les mesures de I’éditeur d’événements correspondent a
celles de la liste de lecture. Sinon, a vous de jouer !). L autre différence essentielle est que cet
éditeur-ci permet de définir des Evénements (bandes verticales correspondant & la valeur de
la commande que vous réglez) persistants jusqu’a I’événement suivant.

Zoom vertical/
Menu d’édition Sélection du mode Sélection d’automation  horizontal
l d’édition (cliquer + tirer)

Curseur de lecture Données d’automation (événements).
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3. Modes d’édition des événements. L’éditeur d’événements peut fonctionner selon plusieurs
modes, détaillés ci-dessous :

a.

Mode Draw (dessin). Dans ce mode, le pointeur prend la forme d’un crayon . Vous
pouvez ajouter des évenements en faisant un clic gauche dans la fenétre principale. Vous
pouvez également faire un clic gauche et faire glisser le pointeur pour définir plusieurs
événements, ou faire un clic droit pour tracer une ligne d’événements.

Mode Brush (pinceau). Ce mode ) ressemble beaucoup au mode Draw, mais ignore
les a-coups de la souris.

Mode Delete (suppression). Cliquez sur le symbole (supprimer) pour activer ce
mode. Vous pouvez alors cliquer sur des événements pour les supprimer ou garder le
bouton de la souris enfoncé et faire glisser le pointeur pour supprimer plusieurs
événements (les événements sont matérialisés par des bandes brillantes dans la fenétre
principale).

Mode Smooth (interpolation). Cliquez sur le symbole [glll| de lissage (interpolation) pour
activer ce mode. Vous pouvez garder le bouton de la souris enfoncé et faire glisser le
pointeur pour surligner une section. Lorsque vous relachez le bouton de la souris, la
courbe des événements est “lissée” et perd son aspect haché. Essayez ! Vous pouvez
aussi activer Auto-Smoothing dans le menu d'édition Edit, pour que les événements
dessinés en mode Draw soient automatiquement lissés.

Mode Select (sélection). Cliquez sur le symbole [@] pour activer ce mode. Lorsque vous
gardez le bouton de la souris enfoncé et faites glisser le pointeur, un champ rouge de
surlignage apparait sur la barre de la téte de lecture. VVous pouvez aussi faire un clic droit
sur la barre de la téte de lecture pour étendre le champ sélectionné dans n'importe quel
mode. VVous pouvez couper cette zone et zoomer dessus depuis le Menu Edit.

Mode Zoom. Le mode zoom vous permet de sélectionner une zone dans I'éditeur
d'événements pour I'agrandir automatiquement a la taille d'affichage.

4. Divers. Voici quelgues points a connaitre quant a I'éditeur d'événements.

a.

Annuler (Undo). Une forme dannulation limitée est disponible dans I'éditeur
d'événements. Cliquez sur CTRL-Z pour annuler la derniére opération.

Positionnement de I’événement initial. Il est possible qu'aprés avoir enregistré une
automation, le réglage d’une commande n’ait pas lieu précisément au bon moment
lorsque la boucle est lue. Vous pouvez corriger cela en tournant le bouton jusqu’a la
bonne position initiale, puis en faisant un clic droit sur ce bouton et enfin en sélectionnant
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c. Apprenez a maitriser cela. Il faut un certain temps de pratique pour maitriser I’éditeur
d’événements et faire en sorte que vos morceaux aient exactement le son souhaité, mais
cela en vaut la peine. Continuez de vous entrainer jusqu'a ce que tout aille bien !

Init Events With This Position. Cela détermine le tout premier événement afin que le
mouvement commence toujours de I'endroit voulu.

d. L’automation modifie les réglages fixes. Si des événements sont associés au réglage
d’une commande, vous ne pouvez plus vous contenter de la régler dans l'attente qu'elle
garde ce réglage. Vous devez passer par I’éditeur d’événements ou enregistrer une
nouvelle automation pour modifier le réglage.

5. Présentation des événements de LFO. Parfois, vous voulez une oscillation basique d’un
paramétre, mais il est difficile de controler la maniére exacte dont I’oscillation va
s’harmoniser avec le morceau. Ce probléme peut étre réglé grace aux événements de LFO,
qui vous permettent de simuler une oscillation parfaite a I’intérieur de I’éditeur d’événements
et d’aligner les crétes/creux sur la grille de tempo .

=3 w4 [] Events - Snare - Channel volume ~
File »
Edit » ]

Toaols Scale levels.., Aty

View LFQ...

Select

»
»
Snap »
¥
¥

Zoom
Target contral

v Relocate events

Auto smoothing
Center 0

Detached

6. Utilisation des événements de LFO. Ouvrez I’éditeur d’événements d’une commande.
Assurez-vous que le Pattern sélectionné est le bon. Sélectionnez a présent la plage sur
laquelle I’oscillation doit étre appliquée a I’aide du mode de sélection ou par un clic droit
dans la barre de la téte de lecture. Appuyez a présent sur ctrl-I ou sélectionnez LFO dans le
menu Tools. Cela ouvrira la fenétre LFO Settings et appliquera immédiatement le LFO a la

zone sélectionnée. Voir ci-dessus.
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7. Jouez avec les réglages principaux de LFO. Notez que cette boite de dialogue comporte
trois sections. Vous pouvez obtenir des offats trés sympas en modifiant les réglages des
sections Start et Shape. La section Start vous permet d’éditer les parametres Value
(hauteur), Range (Profondeur), et Speed (longueur) des ondes. La section Shape vous permet
d’éditer la forme des ondes (sinusoidale, en dents de scie, carrée) et leur phase (décale les
ondes a gauche et a droite).

ol &[G Events - TS404 #1 - Channel volume

Z

Position horizontale

8. Et la section End ? Si vous souhaitez que I’effet du LFO évolue dans le temps, activez la
section End en cliquant sur le bouton rouge. Une fois le témoin allumé, vous pouvez modifier
les paramétres de début (gauche) et de fin (droite) du LFO, et FL Studio se chargera de
moduler progressivement les réglages entre le début et la fin. Cela vous permet d’appliquer
des effets sympas de LFO changeant comme celui représenté ci-dessous. Dans cette
illustration, la forme d’onde carrée du LFO commence sur la deuxiéme mesure et se termine
sur la quatrieme. Au fur et a mesure de l'avancée du LFO, la vitesse d’oscillation (Speed)
augmente tandis que la hauteur (Value) et la profondeur (Range) diminuent du début a la fin.

iid [#[S]~E] Events - TS404 #1 - Channel volume

I:I s ® - Value -GII

Z

Range -‘, -

Speed -ﬁ 3

A Shape

Phase -1‘/
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9.

10.

66

Qu'y a-t-il dans le menu Edit? Dans le menu Edit, vous pouvez supprimer tous les
événements (Edit > Delete All), sélectionner tous les événements (Edit > Select All) et
modifier la couleur et I’apparence de I’éditeur (Settings). Une des commandes les plus utiles
ici est la commande Edit > Turn into automation clip. Comme mentionné précédemment,
cela transforme un évenement automation en clip d’automation. Le processus de
conversion peut légerement changer les choses, mais vous pouvez ensuite ajouter le clip
d’automation a la Playlist et tirer sur ses points de controle de part et d’autre de la ligne pour
les éditer. VVraiment super ! Pour en savoir plus sur les clips d’automation, voir page 73.

Le menu magnétisme ou Snap () est aussi important. Le magnétisme aligne
automatiquement les objets que vous déplacez dans I’éditeur d’événements, par exemple,
pour que leur placement se fasse toujours exactement sur un temps ou une mesure. La
résolution (finesse) du magnétisme peut aussi étre modifiée dans la barre d’outils principale,
toutefois le magnétisme local a priorité sur le magnétisme global (représenté ci-dessous).
Essayez différents réglages pour comprendre I’influence de ce réglage sur le placement des
sélections et des événements. L'intervalle le plus fin est Off, qui cause un calage sur des
points extrémement fins entre les notes. Notez qu'il existe aussi des réglages locaux de
magnétisme pour I'éditeur d'événements, la Playlist et le Piano Roll aussi chacun peut-il
avoir une valeur différente.

Résolution
globale du
magnétisme

2l RN (L ) [ =

E L Bes B

Line

Encore quelques conseils...

* Le magnétisme SNAP ci-dessus est "global”; il existe un
magnétisme local pour le I'éditeur d'événements, le Piano Roll et la
liste de lecture, qui peuvent étre réglés indépendamment.

* Vous pouvez annuler une opération sur un LFO avec Ctrl-Z.
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LE PIANO ROLL (Notes)

Vous avez sans doute déja constaté qu'il existe certaines choses que le séquenceur pas a pas ne
fait pas trés bien. Il est en effet difficile a utiliser sur les mélodies de plus d’une mesure ou
lorsque vous souhaitez jouer des accords a partir d’un échantillon d’une seule note. Le Piano Roll
pallie & tous ces problémes !

1. Ouvrez le Piano Roll. Chargez NewStuff.flp et sélectionnez un Pattern affichant quelques
barres vertes comme ci-dessous. Notez que le séquenceur pas a pas se présente sous un aspect
tres différent. Ces canaux contiennent des données de Piano Roll et plus des pas ordinaires.
Vous pouvez ouvrir I’éditeur Piano Roll de chacun de ces canaux en faisant un clic droit sur
le nom du canal ou un clic gauche dans la mini-fenétre Piano Roll. Ouvrez la fenétre
Piano Roll du canal Ins_Round.

Clic droitici | - [ [0

(Nom du canal) H

Biano roll
P ic iri Rename...
uis ICl

Seticon

Cut itself

Edit

Fill 2ach 2 steps
Fill 2ach 4 steps
Fill gach & steps

Clic gaucheici
(Mini-fenétre Piano Roll)

Insert

Replace »
Clone
Delete. ..

2. Ce qui s’affiche & I’écran. A premiére vue, cette fenétre ressemble & I’éditeur d’événements.
Vous voyez la téte de lecture, les boutons de mode d’édition et de menu d’édition ?
Cependant les "événements" de la fenétre Piano Roll correspondent ici a des notes jouées a
des moments précis et non plus aux réglages de niveau de différentes commandes de FL
Studio. Chaque bande verte horizontale indique le début et la fin d'une note et le clavier
affiché a gauche la hauteur de chaque note. La note désignée ci-dessous est un C5 (do de la
5éme octave), commengant sur le 2eme temps de la 1ére mesure et durant 3/4 de temps.

Regardez ou vous cliquez ! La mini-fenétre Piano roll de
la fenétre de canal a une fonction sympa: pour les
longues partitions Piano roll, elle ouvre le Piano roll a
I'endroit ou vous avez cliqué. Sensass !
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" Changez
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Qu’en est-il de la fenétre du bas du Piano roll ? Elle vous permet de régler toutes sortes de
parameétres de note tels que la dynamique de note (Velocity), le panoramique (Pan) et aussi
I’automation de canal. S’il existe un quelconque événement d’automation dans le Pattern dont
fait partie le Piano roll, vous pouvez le sélectionner aussi et I’éditer dans la fenétre du bas,
comme dans I’éditeur d’événements. Encore plus reposant ? VVous pouvez utiliser le sélecteur
de canal pour changer les Piano rolls dans le Pattern (indiqué ci-dessus comme “Changez ici
le canal”).

Quels types de canaux peuvent avoir des Piano Rolls ? Cette fonction est disponible avec
tous les types d'instrument. Retenez toutefois ceci concernant les canaux d’échantillons.
Vous pouvez utiliser le Piano Roll sur n'importe quel canal d'échantillon, ce qui est pratique
pour la programmation de percussions, mais les accords et les notes tenues fonctionneront
toujours mieux si vous utilisez des échantillons en boucle. Les points de bouclage
permettent de lire indéfiniment I'échantillon et ainsi de créer un son tenu tant que la note est
maintenue (longueur des barres vertes ci-dessus). Si vous n'avez pas d'échantillon mis en
boucle, vous pouvez toujours utiliser le Piano Roll, mais n'oubliez pas que vos notes risquent
de ne pas durer aussi longtemps que vous le voudriez.




|E| Channel settings - PAD_Cloud

sMP ’FWW

Emp|0| deS pOintS ’? PAD Cloud.wav

de bouclage

Wave

C’est de mieux
en mieux tout

ca!

r"

", |Ping po

= Resample

Points de
bouclage

5. Principes de base de I’édition en Piano Roll -

a.

Ajout de notes. Pour programmer une note, vérifiez que vous étes bien en mode Draw
(dessin) en cliquant sur le bouton de mode Draw (ﬂ) ou sur le bouton de mode Brush
(pinceau ), cliquez sur la zone des notes, la ou la note doit commencer, puis relachez.
Saisissez ensuite le milieu de la note et tirez cette derniére vers le haut/bas. Si le projet
n’est pas en lecture, vous devez entendre la note que vous programmez quand vous la
déplacez. La longueur de la note sera celle de la derniére note placée. Pour modifier la
longueur d’une note, saisissez le bord droit de la barre verte et tirez-le.

Magnétisme des notes. La note peut se caler a un endroit que vous ne voulez pas. Dans
ce cas, modifiez le magnétisme de la grille dans la barre d’outils comme vous I’avez fait
avec I’éditeur d’événements (voir section précédente). Si malgré cela vous ne parvenez
pas a régler la longueur de la note comme souhaitée, maintenez la touche ALT pour
supplanter le magnétisme et tirez la note (délicatement !).

Couleur des notes. Vous voyez la rangée composée de 4 boutons de couleur sous les
boutons de mode d’édition ? lls vous permettent de choisir la couleur des notes que vous
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programmez. Cela peut sembler bizarre maintenant, mais le codage par couleur peut
vraiment vous aider a vous y retrouver dans les notes que vous avez programmées. De
plus, le menu Edit vous permet par ailleurs de sélectionner par couleur (Select By Color)
et donc de ne supprimer ou copier et coller que les notes d’une méme couleur. Mieux
encore, les couleurs de note vous permettent de contrdler différents canaux MIDI (voir
I’aide principale dans FL Studio en pressant F1).

Suppression de notes. Deux méthodes s’offrent & vous — clic droit sur la note a
supprimer ou passage en mode de suppression en cliquant sur le bouton du mode Delete
(suppression) (voir la section Editeur d’éveénements).

Annulation des changements. Tout comme dans I’éditeur d’événements, vous pouvez
annuler ("undo™) une opération depuis le menu Edit ou en appuyant sur Ctrl-Z.

Couper, copier et coller des notes. Activez le mode Select en cliquant sur le bouton du
mode Select (voir la section Editeur d’événements) puis cliquez et tirez pour surligner
certaines notes. Utilisez ensuite les options Cut (Couper), Copy (Copier), Paste (Coller)
du menu Edit ou les touches Ctrl-X, Ctrl-C et Ctrl-V. Le collage peut s’avérer plus
capricieux qu’il n’y parait. Les notes sont collées selon leur position d'origine, sur la
premiére mesure affichée a I’écran. Donc pour coller des notes de la mesure 1 a la 2,
sélectionnez les notes de la mesure 1 et appuyez sur Ctrl-C pour copier, puis faites défiler
jusqu’a la mesure 2 et appuyez sur Ctrl-V. Si les notes ne s’affichent pas, elles sont sans
doute sur la mesure 1. Appuyez sur Ctrl-Z pour annuler et recommencez I’opération.

6. Accords et harmonies. L’une des fonctions les plus intéressantes du Piano Roll est la
possibilité de jouer des notes simultanément pour créer des accords et des harmonies. 1l vous
faudra une certaine sensibilité musicale pour tirer profit de cette fonction, méme si FL Studio
vous facilite les choses grace a I’option Chord du menu Edit. Sélectionnez le type d’accord
souhaité puis activez le mode Draw. Vous pouvez maintenant ajouter des accords complets
dans le Piano roll.
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7. Pitch-Bend sur les notes. C'est un effet tres sympa, mais qui ne fonctionne que sur les
plugins natifs de FL Studio comme Sawer (pour faire varier la hauteur d'un instrument VST,
vous pouvez automatiser la commande de hauteur du canal dans lequel il est chargé, vous
vous rappelez de I’édition d’événement ?). Si vous cliquez sur l'icbne de pente en haut a
gauche juste sous le bouton du menu Edit, vous pouvez insérer des notes a pitch-bend (aussi
appelées notes glissées). Pour voir comment cela fonctionne, ajoutez une longue note dans le
graphique puis placez une note avec Pitch Bend au-dessus ou au-dessous. Veillez a ce que les
deux notes se chevauchent. La longue note est jouée jusqu’a ce qu’elle atteigne la portion en
Pitch Bend. La hauteur de la note monte alors en direction de la note glissée et reste a cette
hauteur jusqu’a la fin de la note originale. Plus la note glissée est longue, plus I’effet de Pitch
Bend est long.
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Réglage des notes. Vous vous souvenez de I’éditeur graphique du séquenceur pas a pas ? |l
permettait de régler individuellement le volume, la coupure et la résonance du filtre, etc. pour
chaque note. Des fonctions similaires existent au bas du Piano Roll. Quand vous programmez
une note, vous obtenez en bas une colonne qui indique le niveau du paramétre choisi dans le
menu déroulant de gauche (Sélecteur d’événement ci-dessus). Une fois les notes ajoutées,
vous pouvez modifier la valeur de leurs paramétres en tirant sur le haut de ces colonnes avec
la souris. La barre horizontale représente la longueur de la note. Vous pouvez régler Velocity
(volume), Pan (panoramique) , Cutoff (fréquence de coupure), Resonance et Pitch
(hauteur). Vous pouvez méme utiliser cette fenétre comme éditeur d’événements des réglages
de panoramique, de hauteur et de volume d’un canal. NOTE : vous pouvez aussi changer
n’importe quelle propriété de note en double-cliquant dessus.

Importation de morceaux MIDI. Dans I’option MIDI du menu File, vous trouverez deux
méthodes d'importation directe de fichiers MIDI dans le Piano Roll. 1l existe des tonnes de
fichiers MIDI pour diverses mélodies populaires entendues ¢a et la. Vous pouvez maintenant
les aspirer directement dans FL Studio et les utiliser dans vos morceaux. N'est-ce pas sympa ?
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CLIPS AUDIO, DE PATTERN & D'AUTOMATION

IMPORTANT : Ce guide est un guide de prise en main général commun a toutes les éditions de FL Studio.
Certaines fonctions n'existent toutefois que dans certaines éditions. FL Studio Fruityloops Edition n'a pas
de piste audio ni d'éditeur d'onde intégré. Veuillez consulter notre site http://flstudio.image-line.com pour
connaitre les conditions de mise a niveau.

FL Studio Producer Edition vous permet de travailler avec des clips audio, de Pattern et
d'automation.

Choru
| Panning +«l Panning # Panning | Panning «l Panning #l Panning ¢« Panning

Em s sl ee— 0 | e—
#Vocals: The Girl - Stereo view #Vocals: The Girl - Combined view *-Vocal:

D .
Vocal volume " ¥ocal Channel Vol envelope
automation

Main autom... [N

La section haute de la Playlist peut contenir les données audio, de note et d'automation.

Les pistes sur lesquelles sont placés ces clips ne sont pas exigeantes, vous pouvez y placer
n'importe quel type de clip n'importe ou, vous pouvez méme les superposer. La zone "piste” est
un endroit remarquable pour organiser et éditer votre morceau. 1l est aussi possible de couper et
de diviser n'importe quel type de clip en plusieurs morceaux et de les réarranger, tout cela de
facon non destructive, sympa !

Chagque clip de la zone supérieure des pistes de clips aura un instrument de canal associé. Clips
audio : ce sont des versions spéciales des canaux d'échantillons. Clips d'automation : ce sont des
plugins de contrdleur interne dédiés. Clips de pattern : ce sont des données de pattern. Rappelez-
VOUus que vous pouvez convertir un événement d’automation en clip d’automation si vous le
désirez. Vous noterez aussi que le clip de Patterns avec des événements a I’intérieur affiche les
données d’événement, mais celles-ci ne sont pas directement éditables dans la Playlist
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(contrairement aux clips d’automation), double-cliquez dessus pour ouvrir [I’éditeur
d’événements.

Chaque canal de clip audio/automation ajouté dans le séquenceur pas a pas devient disponible
dans les pistes audio et vice versa — faire glisser un échantillon sur les pistes de clips du haut
génere un canal de clip audio (a moins qu'un canal ayant le méme échantillon existe déja). Les
pistes audio sont un excellent moyen d'arranger un jeu de grands clips audio, tout en visualisant la
forme d'onde dans les pistes. Vous pouvez couper et diviser les clips audio en plusieurs morceaux
et les arranger indépendamment sur les pistes audio.

Pour placer des clips audio/d’automation & de Pattern, passez en mode crayon ou pinceau et
faites un clic gauche sur une piste de clips (pour peindre des clips audio et d’automation, ils
doivent exister au préalable dans votre projet, sinon vous pouvez faire glisser un échantillon sur la
Playlist et un clip audio sera automatiquement créé). Le mode pinceau vous permet de dessiner
d'un coup de multiples occurrences du clip audio (tenez enfoncé le bouton de la souris et faites
glisser cette derniére).

Pour effacer un clip, cliquez dessus avec le bouton droit de votre souris ou utilisez le bouton
gauche de la souris en mode effacement (erase).

Pour basculer d’une occurrence de clip a la lecture d'une autre, ouvrez le menu clip (clic
gauche sur la fléche dans le coin supérieur gauche du clip) et depuis le menu de sélection de canal
(Select Channel), choisissez le clip de remplacement.

Pour ouvrir la fenétre Channel Settings du canal associé a I'occurrence du clip, ouvrez le menu
clip et sélectionnez Channel Settings.

Pour écouter un clip audio, sélectionnez Preview (pré-écoute) dans le menu clip pour entendre
I'échantillon du clip audio (pressez le bouton Stop du panneau de Transport pour arréter la pré-
écoute).

Les clips d'automation peuvent automatiser tout parametre éditable sur la totalité du morceau
(plutdt qu'une automation par événement). Un emploi commun de ces clips d'automation est de
réaliser un fondu entrant/sortant pour un clip audio en automatisant son volume. Toutefois, les
clips d'automation vont beaucoup plus loin que le contr6le du volume des clips. N'hésitez pas a
tester leur emploi. Utilisez le commutateur approprié pour alterner la gestion entre clips audio,
clips d'automation et clips de Pattern.
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ENREGISTREMENT AUDIO

Qu'en est-il de I'enregistrement audio ? Il vous faudra FL Studio Producer edition ou
supérieur ainsi qu'un pilote de carte son ASIO sélectionné dans les options audio (pressez F10
sur votre clavier pour les ouvrir) afin d’enregistrer directement l'audio dans FL Studio. C'est un
domaine immense (mais gratifiant) qui est soigneusement couverte par le mode d'emploi en ligne.
Pressez F1 dans FL Studio et cliquez sur la section "Recording Audio, Notes & Automation™ dans
Contents, puis sur la page "Audio Recording". Toutefois, nous vous indiquerons que I’entrée
audio dans FL Studio se fait au travers du menu Mixer IN menu.

[ 1OUTY (none)
)

Les entrées audio externes se sélectionnent depuis le
menu IN du mixer de FL Studio. Le menu "IN" déroule
une liste des entrées de carte son disponibles (micro,
ligne etc). La copie d'écran ci-dessus affiche (none) car
aucune entrée n'est encore sélectionnée (chaque piste de
mixer a son propre menu d’options d’entrée externe). Les
options d'entrée ne seront visibles que si un pilote de
carte son ASIO est activé. Note: les noms d'entrée
affichés dans le menu déroulant sont fournis par le pilote
de la carte son et sont parfois étranges, aussi peut-il étre
nécessaire de faire quelques essais pour trouver la bonne

@e. Il est temps d’acheter des MICROPHONES !!!!1]
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EDITEUR D'ONDE/ENREGISTREUR EDISON

IMPORTANT : Ce guide est un guide de prise en main général commun a toutes les éditions de
FL Studio. Certaines fonctions n'existent toutefois que dans certaines éditions. FL Studio
Fruityloops Edition n'a pas de piste audio ni d'éditeur d'onde intégré. Veuillez consulter notre
site http://flstudio.image-line.com pour connaitre les conditions de mise a niveau.

Edison est un éditeur audio et un enregistreur de pistes-mixer entiérement intégré. Edison se
charge dans un slot (emplacement) d'effet (dans n'importe quelle piste de mixer) d'ou il enregistre
ou reproduit l'audio. Vous pouvez charger autant d'occurrences d'Edison que nécessaire dans
n'importe quel nombre de pistes de mixer ou slots d'effet. Pour ouvrir Edison, pressez Ctrl+E
dans un canal d'échantillon, ou chargez-le depuis le menu des effets dans les pistes de mixer.

De nombreux outils puissants sont disponibles dans Edison. Une bréve description de certains
outils et la fagon de les ouvrir sont données ci-dessous.

FREEZE ) MOISET. (=

L'outil Amp d'Edison fonctionne comme les commandes de piste du mixer, incluant séparation
stéréo, panoramique, volumes des canaux L et R couplés et indépendants. Pour ouvrir l'outil,
pressez Alt+A dans Edison ou utilisez Tools>Amp>Amp option.

Le moteur de Reverb a convolution d'Edison fonctionne en multipliant deux signaux audio dans
le domaine des fréquences comme une sorte de "moyenne mobile”. Un effet reverb est obtenu
guand un fichier d"'impulsion™ entre en convolution avec le fichier d'onde d'origine. Les fichiers
d'impulsions de reverb sont créés en enregistrant des sons courts et nets dans des espaces réel ou
au travers d'unités de réverbération. Le son enregistré est alors une empreinte acoustique de
I'espace réverbérant. Cette technique est équivalente a I'échantillonnage d'un instrument et est trés
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performante, vous permettant d“'emprunter” les impulsions d'équipements trés onéreux ou
d'espaces réels vous n'auriez jamais la chance d'enregistrer. Une reverb a convolution sonnera
comme l'espace ou matériel d'origine (avec les réglages particuliers utilisés). Bien sdr, internet
déborde d'impulsions gratuites a télécharger pour votre plaisir (voir "Ressources d'impulsions" ci-
dessous).

Pour ouvrir le dialogue, vous pouvez faire un clic gauche sur le bouton de reverb a convolution

, presser Ctrl+R dans Edison, ou utiliser I'option Tools > Spectral > Convolution Reverb.
Une fois qu'une impulsion est chargée, vous pouvez accomplir toutes les fonctions d'édition
d'Edison dans la fenétre de prévisualisation spectrale. Faites un clic droit sur la prévisualisation
spectral pour ouvrir les options d'édition.

Convolution reverb
Dptions

(=) Use data outside selection
Delay E ) Dry ({7 Wet‘
* B (=) Add tail

Impulse: Default

FREEZE () noiseT. (D) REmions (O} snRe (C) st ()

L'outil Blur d'Edison fonctionne comme la reverb a convolution, en multipliant un son
d'impulsion (dans ce cas un bruit) par la forme d'onde. La fonction de I'impulsion est multipliée
en croix avec la source selon une moyenne mobile, pour estomper ou "brouiller" le son. La
multiplication est déterminée par une enveloppe que l'utilisateur peut choisir. Pour préserver une
plus grande quantité des qualités d'origine du son, utilisez des enveloppes a forme plus étroite.
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Options

amount () Delay Mix@

n

Envelope

A
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Preview Accept

L'outil Equalizer accentue ou coupe les fréquences conformément a une enveloppe de correction
définie par Il'utilisateur. L'exemple ci-dessous montre l'effet de la courbe de correction
sélectionnée sur un échantillon de bruit blanc. La fréquence est affichée sur I'axe horizontal, le
temps sur l'axe vertical (I'échantillon commence en haut et finit en bas) tandis que
I'intensité/saturation de la couleur représente I'amplitude de fréquence.

Pour ouvrir I'outil, vous pouvez faire un clic gauche sur le bouton d'outil EQ E , presser Ctrl+E
dans Edison, ou utiliser I'option Tools > Spectral > EQ.

Equalizer

Envelope

Freq scale

10k

FREEZE () SNAF (=

L'outil Time Stretch / Pitch Shift vous permet de modifier indépendamment la durée, la hauteur
et les formants d'un échantillon. Edison et plus généralement les canaux d'échantillons et I'outil
Slicer utilisent les algorithmes élastique Pro de zplane pour offrir un étirement temporel (time
stretch) / transposition (pitch shift) répondant aux normes des productions professionnelles et des
applications broadcast.
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Pour ouvrir l'outil, vous pouvez faire un clic gauche sur le bouton d'outil Time , presser
Alt+T dans Edison, ou utiliser I'option Tools > Time > Time stretch / Pitch shift. Pour ouvrir la
boite de dialogue paste-stretch (coller-étirer), pressez Ctrl+Alt+V ou utilisez I'option Tools >
Edit > Paste stretch. La boite de dialogue paste-stretch n'est disponible qu'aprés avoir coupé ou
copié une sélection d'échantillon.

L'accordeur de boucle ou Loop Tuner d'Edison vous permet de supprimer les clics, pops ou
coups d'une boucle. Le Loop Tuner n'est pas un outil de détection automatique de boucle, il est
destiné a adoucir les boucles qui ont déja été définies. Sachez que pour effectuer le processus de
lissage de boucle, certains réglages déplacent automatiquement le point de début de boucle. Pour
préserver le point de départ de votre boucle, réglez les parametres Crossfade et Snap au
minimum.

Beat slicing. Edison posséde un éventail d'outils de découpage temporel (beat slicing) et
étirement de boucles de batterie (Tools > Time > Drum(loop) stretch) qui vous permettrons de
créer vos propres rythmes découpes.

Marker #4 Marker #5 Marker #6

FREEZE () NOISET. (= REGIONS (= SMAF (=) SLDE ()

Super ! Frappe-moi avec tes baguettes ! Je vis pour
le rythme. Beats rapides, beats lents, gros beats...
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PARTAGE DE VOTRE TRAVAIL

Votre morceau est a présent terminé — vous souhaitez sans doute le sortir de FL Studio pour
pouvoir le graver sur CD, le poster sur internet ou I’éditer dans un autre programme. La fonction
Export est la pour ¢a, voici comment I’utiliser.

1.

Exportation au format Wav, Ogg ou MP3. Cette option est accessible depuis le menu File
principal. Que vous choisissiez le format Wav, Ogg ou MP3, le systéme vous demande le
nom du fichier et la boite de dialogue ci-dessous s’affiche. Vous y trouverez de nombreuses
options, et nous n'avons pas assez d'espace pour entrer dans les détails. Pour une explication
de chaque bouton, allez avec F1 dans I'aide en ligne, tout y est.

Rendering to EuroGloss_TheDecizionMix_2.wavl....[ |

Output format(s)

[ way [l MP3

4| MIDI | OGG
355732Kb

1 1103

Looping mode

Leave remainder

Quality
Sampler interpolation:

6-point sinc

.| Dithering

WAV
Depth:

168it int
MP2 [ 066
Bitrate: 160Kbit

(l

Orptions

Mazette ! Ca a l'air
compliqué...

2.
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.| Alias-free TS404 ", Split mixer tracks
=& HQ for all plugins .| Save ACIDized™
[ Disable max poly | we slice markers

| Delay compensation

Badkground rendering

Format Wav, Ogg ou Mp3 ? Wav est un format de fichier de son brut. Les fichiers sont de
grande taille mais offrent un son d’excellente qualité (comptez environ 10 Mo par minute
selon le réglage du paramétre de résolution Bit Depth). Les fichiers Wav 16 bits a 44,1 kHz
peuvent étre gravés sur CD. MP3/Ogg sont des formats compressés donnant de plus petits
fichiers, mais la qualité audio peut s’en trouver légérement altérée (comptez environ 1 Mo par
minute selon le réglage du paramétre de taux de compression ou débit numérique Bit Rate).




Si les fichiers doivent étre partagés sur Internet, MP3/Ogg sont parfaits.

3. Faut-il utiliser la fonction ""Background Rendering'" (conversion en tache de fond) ? La
conversion peut prendre longtemps et monopoliser votre processeur, surtout si vous optez
pour des options de plus haute qualité dans la section Quality. En cliquant sur Background
Rendering, la fenétre FL Studio est réduite et le rendu est calculé en tache de fond. Cela
prend plus longtemps...mais il y a plein de choses a voir sur internet en attendant.

4. Exportation des boucles comme fichier compressé (Zip). Elle est particulierement utile
pour transférer vos projets FL Studio sur le Web. Cette fonction compresse en un fichier Zip
le fichier FL Studio désigné et tous les échantillons utilisés par ce fichier. Notez que cela ne
sauvegarde pas les plugins d’instrument que vous avez utilisés, juste les échantillons.

5. Options Project Bones et Project Data Files. Ces options vous permettent de sauvegarder
de nombreuses informations concernant votre piste. L'option Project Bones sauvegarde un
fichier avec tous vos presets, informations d'automation etc. pour les recharger
ultérieurement. Project Data Files sauvegarde en un méme emplacement de votre disque dur
tous les échantillons et autres données brutes utilisées.

6. Ou mettre vos morceaux en ligne ? Il existe de nombreux sites sur lesquels les artistes
peuvent gratuitement proposer leurs fichiers MP3. http://www.mp3.com est sans doute le plus
connu, mais les morceaux des amateurs y sont généralement cachés derrieére les morceaux
plus en vogue et placés la a des fins commerciales. Image-Line (c’est nous) a un forum
d’échange de morceaux intitulé Song Exchange (http://forum.image-line.com/index.php) si
vous souhaitez avoir un retour de la part d’autres musiciens utilisant FL Studio. C’est un
excellent moyen de recevoir les avis de colléegues FLoopers (comme vous). Si vous n’étes
intéressé par aucune de ces options, vous pouvez toujours créer votre propre site auprées d’un
des nombreux services d’hébergement gratuits. Saviez-vous que nous faisons aussi notre
proper outil de création de site web? Il s’appelle EZGenerator, découvrez-le ici -
www.ezgenerator.com. Trop facile !!

@ partager votre travail avec le public,

envisagez de faire votre propre site web !

Essayez EZGenerator Web Site Builder
(prononcez easy generator), I'outil que nous
employons pour faire et entretenir nos sites
web.

C'est un autre logiciel de haute qualité
développé par Image Line Software !

Version d'essai gratuite sur :
http://www.ezgenerator.com
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CONTROLEURS EXTERNES

Saviez-vous que vous aviez déja au moins deux “controleurs externes" branchés a votre PC ?
Votre clavier de saisie et votre souris. Ils ne produisent pas de sons mais envoient des signaux de
commande a votre PC quand vous pressez des touches ou bougez votre souris. De méme, les
controleurs USB/MIDI externes ne sont que des dispositifs envoyant des signaux de commande a
votre PC, méme s'ils sont congus pour jouer comme un clavier de piano, bouger comme une table
de mixage, une platine tourne-disque ou tout équipement servant a faire/mixer de la musique.
Avec un contrbleur branché, vous pouvez piloter les commandes et commutateurs de FL Studio,
ou jouer d'un plugin d'instrument comme d'un synthétiseur. Le seul piége est que le contrbleur
n'est pas dédié a des fonctions particuliéres, vous devez indiquer a l'avance a FL Studio ce que
doit faire chaque commande du contréleur (c'est comme affecter des touches de votre clavier pour
contrbler un jeu, un inconvénient mineur en contrepartie du luxe de pouvoir changer en méme
temps la fréguence de coupure et la résonance d'un filtre ). Chague commande du contrbleur peut
étre associée a un curseur ou bouton différent de FL Studio. Si vous avez un contréleur, cette
section vous indiquera comment le faire fonctionner avec FL Studio. Si vous n'en avez pas,
procurez-vous en un. Si vous ne savez pas lequel choisir, envisagez un petit clavier MIDI de 2
octaves avec quelques commandes, vous ne le regretterez pas! Nous présenterons d'abord
quelques-uns des contrdleurs les plus répandus, puis nous vous dirons comment les configurer.

1. Quelques exemples de controleurs.

Korg NANOKEY & NANOKONTROL - Ce sont de minuscules contréleurs (avec un prix
tout aussi minuscule), remarquables pour ceux qui se déplacent avec un ordinateur portable.
Celui avec les commandes a 9 boutons rotatifs assignables et 9 curseurs pouvant étre associés
aux boutons et curseurs de FL, des commandes de transport pour lancer/arréter FL Studio et
se branche au PC en USB. Facile ! Il existe toute une gamme de petit claviers de commande
MIDI, prenez le temps d’utiliser Google et d’y jeter un coup d’ceil !

L \H \\

HORG
T

Des nanites ? Mais ce n’est pas dangereux !?
Faites gaffe aux réplicateurs !!
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Behringer B-Control. Sinon, le B-Control a de plus grands boutons et curseurs. 1l se branche
aussi au PC par USB. Trop facile !

Autres contrdleurs. - Sivous prenez la chose au sérieux et n‘avez que le ciel pour limite, le
Keystation Pro-88 a plus de commandes que vous n'en aurez sans doute besoin. De méme, si
vous possédez déja un autre équipement MIDI, comme la MPC AKAI (ci-dessous), elle peut
aussi contréler FL (la MPC est le complément parfait de notre plugin FPC !).

Whao ! C'est comme
apporter une arme a
feu dans un combat a
I'arme blanche ! Vous
étes slr que cette
chose ne peut pas
faire de sons toute
setlle ?

La légendaire MPC AKAI + FPC = bonheur ©
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2. Configuration de votre controleur.

Branchez votre contrbleur au PC (USB ou MIDI). Aujourd’hui, la plupart des
controleurs MIDI ont un cable USB, mais si votre équipement MIDI est plus ancien, il
aura des cables MIDI (& grands connecteurs ronds 5 broches). Il vous faut une interface
MIDI-USB pour votre PC. Note : le MIDI n’est pas une liaison audio — il transfere des
données de note, de mouvement de commande et de changement de programme pour que
votre contr6leur pilote des instruments virtuels et/ou que FL Studio fasse jouer du
matériel MIDI connecté. Pour utiliser les sons d’un synthé externe (dont FL Studio
joue), vous devez faire les connexions MIDI (évoquées ici) ET audio aux entrées de votre
carte son pour que FL Studio puisse enregistrer les sons qu’il déclenche sur I’appareil
MIDI externe par sa sortie MIDI Out. Consultez le manuel de FL Studio (touche F1) pour

plus de détails.

a. Allumez le contréleur (attendez qu’il soit détecté par Windows) et ENSUITE lancez
FL Studio. Pressez F10 pour ouvrir les réglages du systéme. Pour le moment,
sélectionnez simplement "Generic Controller" (contrdleur générique) dans le champ
"Controller type" (type de contrbleur), ou votre contrdleur s’il s’affiche. Tournez les
boutons de votre contrdleur. Si tout est ok, vous devez voir une petite diode "Midi" rouge
clignoter prés de la barre de conseil de FL Studio quand vous tournez un bouton ou

pressez une touche. Si c'est bon, parfait ! Sautez les étapes ¢ a e. Sinon, continuez.

|
1. Cliquez ici
osoft MIDI Mapper ic MIDI Mapper
5B ®-Fi Synth A [CEE0] Hardware synthesizer
SEB ®-Fi Synth B [CSED] Hardware synthesizer
Microsoft G5 Wavetable SW Synth Software synthesizer
L | Send master sync Part number:
: =
> Puis ici B 3. Puis ici et
. [0 Auto accept detected contraller omni preview MIDI channel: 7 .
- _ sélectionnez
O] Support hold and sostenuto Song marker jurnp MIDI channel: E .
4. Etici Record ko step sequencer Playist ive mode MIDL channel:  [2] generic
Generator muting MIDI channel: E con t ro I I er.
Toggle on release
5. Et enfin ici
Link note on velocity ta: m
Link release welocity kot m
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d.

§ FL STUDID — La petite
rouge ?
FILE EDIT CHANMELS VIEW OPTIONS TODLS HELP Allumée

Project loaded...

Vérifiez que dans le menu Options I’option Enable MIDI Remote Control est bien
cochée. Si elle ne I’est pas, cliquez dessus et regardez si le témoin MIDI s’allume. Lisez
ce qui suit si le témoin ne s’allume toujours pas.

FLooper : Salut, j'ai besoin d'un clavier de
commande pour FL Studio.

Revendeur de matériel informatique :
DVORAK ou AZERTY ?

FLooper

Configurez votre périphérique d’entrée MIDI. Si le témoin reste éteint lorsque vous
tournez les commandes du contréleur, ouvrez la fenétre MIDI Settings (depuis le menu
Options ou en pressant F10). Cochez la case Remote Control Input. Si vous y voyez le
mot "none" (aucune), vous devez choisir une entrée. Généralement, vous disposerez d'un
certain nombre de choix a tester pour trouver le bon.

Prét a
envoyer
la

sauce ?
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Guide de dépannage: Checklist. Si le témoin rouge est toujours éteint lorsque vous
actionnez les commandes du contrdleur, voici une liste des points a vérifier.

* Avez-vous réglé le bon type de contréleur a I’étape b ?

* Avez-vous activé I’option "Enable MIDI Remote Control" a I’étape ¢ ?

* Avez-vous sélectionné la bonne entrée MIDI a I’étape d ?

* Votre contrleur USB est-il détecté OU vos cables d’entrée et de sortie MIDI sont-ils
inversés ?

* Avez-vous branché le controleur a la prise secteur ?

La partie amusante — Association d'une commande a votre contréleur :

86

a.

Faites un clic droit sur la commande que vous souhaitez associer au controleur.
Dans ce cas, nous essaierons la commande générale du volume d’un canal d'échantillon.
Faites ensuite un clic droit sur la commande et sélectionnez Link to controller pour
afficher la fenétre Remote controlling settings.

| Remote control settings

Remove conflicts
Reset MIDI controller

Edit events Channel ([ Controller [Sie]

IC P T,

| Auto detect
Init song with this position | Mapping formula

Create automation dip Input

Link to controller...

*. Smoothing | Reset
Copy value
Time -(F-
Accept

Tournez un bouton du contrbleur. La fenétre Remote controlling settings doit
disparaitre et la commande de volume de canal doit maintenant bouger en réponse aux
mouvements de votre bouton physique. Vous y étes !

Réduisez la mémoire tampon autant que possible. Précédemment, nous avons expliqué
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le curseur de taille de mémoire tampon ou "buffer length" (accédez a ce paramétre en
appuyant sur F10 puis en cliquant sur I’onglet Audio). Ce curseur détermine le délai
entre le moment ou vous tournez une commande et celui ou le son joué par FL Studio
change. Vous voulez donc qu'il soit faible. Toutefois, avec un réglage trop bas, le son
sera saccadé. Recherchez le juste milieu. Si vous ne pouvez régler la mémoire tampon sur
une valeur suffisamment faible, j'ai bien peur qu'il ne vous faille un ordinateur plus
rapide. Désolé...

3. Quelles commandes peuvent étre affectées au controleur ? Pratiquement toutes. Pour
mémoire, toutes celles éditables en Automation. Rappel : Pour savoir si une commande peut
étre affectée a un contréleur MIDI ou étre enregistrée en automation, placez le pointeur de la
souris dessus et assurez-vous que les deux points rouges s’allument dans le champ
d’information.

4. Et les contr6leurs internes ? Enfin, nous pouvons vous parler des plugins de commande
interne référencés en section Effets (Formula Controller, Peak Controller et X-Y Controller).
Ce sont des plugins avec des commandes (“"contréleurs") qui peuvent piloter d'autres
commandes. Vous suivez ? Prenons comme exemple le Fruity X-Y Controller. Ouvrez la
fenétre Mixer (F9) et placez un Fruity X-Y Controller sur la piste master du mixer.

Mixer - Master

(TR FosT
None

| O o Lk
-6l J

a. Le Fruity X-Y Controller vous permet de piloter deux boutons rotatifs a la fois en
associant l'un d'eux a la dimension X (horizontale) dimension et l'autre a la dimension Y
(verticale). Quand vous saisirez le cercle de la fenétre principale et le déplacerez, les deux

87




®

88

commandes auxquelles il est associé changeront. C'est particuliérement pratique pour
piloter a la fois la fréquence de coupure et la résonance.

I-['|i"—] Channel settings - Kick

/ Remote control settings
FAN NoL F'ITIZ:H. x I New Iink
SMP NS |[MISC | FUNC Vi —
| %4 REm
PAN |VYOL CUT RES PITCH / :
! ] MIDI controller
Ulid 115 | Envelope I
= , Channel [{ifl Controller [FE
/ . Omni [y Muto detect
/
] Internal controller
/ [none] h

= J
o Reset ! 1
b v iyl (Masker) - ¥

7 INPLT

Edit events /A

.| Glabal [default 1:1 mapping]

Init song with this positign

Copy walue

Associez le bouton Cutoff a la valeur X du contréleur interne, comme ci-dessus. Associez
maintenant le bouton Resonance a la valeur Y. Puis ouvrez la fenétre Fruity X-Y
Controller, lancez la boucle, et déplacez le cercle pour écouter les changements
simultanés de Cutoff et de Resonance. Cool, non ?

'_@ Fruity X-¥ Controller... [][] |:|—I

Voila, c'est tout. Amusez-vous !
N'oubliez pas qu'une aide en ligne plus
compléete est présente dans FLStudio
(F1) et en ligne sur
http://flstudio.image-line.com.
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BeatSlicer, 43, 54 Editeur audio, 83
BeepMap, 32, 33, 34, 35 Editeur d’échantillon, 83
BooBass, 32, 33, 36 Editeur d’événements, 65, 68, 69, 70, 76, 77, 79
Bouton play, 12, 14 Editeur d’onde, 83
Buffer Length, 10, 63, 65 Editeur d'événements, 68, 69, 70
Buffer underrun, 10 Editeur graphique, 24, 25, 26, 68
BuzzMachines.com, 59 Effet Glitch, 63
Effets, 16, 52
Effets Buzz, 59
C Effets Fruity, 35

Egaliseur, 55, 58, 59, 61

Canal layer, 47, 49, 50 Enregistrement
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automation, 70
Enregistrement live, 59, 61, 68, 70
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